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Chapter 1

Indexing

When you index, you download a batch to work on. The batch may be just one image
with several names, such as a census page. Or a batch may be several images with one or
more names per image.

You can stop at any time and return later to finish a batch. You can also download a batch
and work offline while disconnected from the Internet. When you are finished indexing
the batch, you can reconnect to the Internet to submit the batch.

My Batches

The My Batches section of the FamilySearch indexing start page shows the batches you
have downloaded until they are submitted or returned.

One of the main purposes of FamilySearch indexing is to move the indexing work along
without delay. You have seven days in which to finish a batch. The due date is listed in
the My Batches area. The system will warn you when a batch is about to expire by listing
the batch information in red. If you cannot finish the batch, after seven days it will
automatically be retrieved by the system and assigned to the next indexer who requests
a batch for that project. For most projects, you will have seven days to complete the
batch. Occasionally there may be projects with shorter deadlines.

FamilySearch indexing cannot extend the due date for batches. To complete the process
of getting projects available for patron research, projects must stick to a schedule. If an
indexer were to keep a batch for an extended period of time, this process would be
significantly delayed.

When a batch is retrieved by the system, any data you entered is saved, as long as you
were working online, or came online to save the batch. Each time you exit the program
after working online, the system automatically saves your data.
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Figure 1: FamilySearch Indexing Start Page

Viewing Messages

You can view messages from FamilySearch headquarters or from your local group
administrator or stake indexing director.

Important messages may appear in a separate window for you to read and close after
you sign in. These important messages will continue to appear in a separate window
each time you sign in until you delete the message from the list.

1. On the FamilySearch indexing start page, in the My Messages section, click a message
in the list to view it.

The date the message was sent is displayed.

Note: If you double-click a message in the list, it will open in a new window.

2. To print or save the message, do the following:

a. Click once in the message body.
b. Press Ctrl+A to highlight and select the message text.
c. Press Ctrl+C to copy the text.
d. Open a word processing program, such as Word.
e. Click once in the body of the new document.
f. Press Ctrl+V to paste the copied text.
g. You can then print or save the message.

3. To delete a message from the list, click the message in the list to highlight it, and
then click Delete Message.

Most messages are automatically deleted after 30 days.
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Setting Goals

You can set goals for yourself. The system will measure the number of records you have
submitted against the goals you have set and report your progress.

1. On the FamilySearch indexing start page, under the My Goals tab, click Set New
Goal.

2. Click the down arrow at the right of Period Starting Date, and select a starting
date from the drop-down calendar.

3. Click the down arrow at the right of Period Ending Date, and select an ending
date from the drop-down calendar.

4. In the Number of Records to Index field, enter your goal for how many records or
names you would like to index in the time period you indicated.

Note: If you click the up or down arrow, it increases or decreases the goal by 10.

5. For arbitrators, in the Number of Records to Arbitrate field, enter your goal for how
many records or names you would like to arbitrate in the time period you indicated.

Note: If you click the up or down arrow, it increases or decreases the goal by 10.

6. Click OK.

Your goal is listed in the My Personal Goal section. As you submit batches, the target
rate will change, showing how many records to do each day to reach your goal.

Viewing History

You can view the history of the projects you have indexed or arbitrated, how many
names you have submitted, and how many points you have earned.
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The number of names submitted is updated each time a batch is submitted. Totals for
the month are reset at the end of the day on the last day of each month.

1. On the FamilySearch indexing start page, click the My History tab.
The points you have earned are displayed.

2. To view how many names you have submitted, click Names Submitted.
You will see a list of the number of names submitted for each project. The total
number of names submitted for all projects appears at the bottom of the list. If you
are an arbitrator, names arbitrated are listed similarly.

3. When you are finished viewing the history of names submitted, click Close.

You can also view the total number of records indexed or arbitrated at the bottom left
corner of the indexing start page (under the My Messages section).

What Are Points?

Points are earned for each record you index. All records receive at least one point. Some
records receive from two to ten points, depending on the difficulty of the indexing
project.

We sometimes refer to the number of names indexed, but it is really the number of
records. For example, one line on a census is counted as one record and contains one
name. A marriage document is counted as one record, but will have two names and
sometimes more if the parents are listed. The number of names submitted and points
given is actually based on the number of records, not the number of actual names.

The Download Batch screen lists the number of points you can receive for each record
in a project. The difficulty level is based on several factors. More difficult batches typically
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have fewer names per batch, but take longer to index. Therefore, the point system makes
it possible for indexers to spend the same amount of time on beginning, intermediate,
and advanced batches and still end up with a similar amount of points. This allows
indexers the opportunity to work on projects where they feel the most comfortable
without feeling compelled to work on more difficult projects simply to gain more points.

Figure 2: Download a Batch with points

If you index 50 records in a beginning batch with a point level of 1, you will receive 50
points (50 records X 1 point each = 50 points). If you index 10 records for an intermediate
batch with a point level of 5, you will receive 50 points (10 records X 5 points each =
50 points).

Points are accumulated at the end of each day. Points can help you keep track of your
personal contributions.

Viewing Arbitration Results

You can review submitted batches to see how often you agree with the arbitrator.

After batches have been arbitrated, they will be available for you to view. You can see
the information in one of your batches that the arbitrator changed. By reviewing the
differences, you may identify areas for improvement in the future.

The batches that you have indexed are available for 90 days. After that, they are removed
from the list.

1. On the FamilySearch indexing start page, click the Arbitration Results tab.
An arbitration agreement score for all the indexed batches that have been arbitrated
in the last 90 days is shown.
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2. Click Review Batches.
A new browser window opens.

3. On the Sign in window, enter your user name and password, and click Sign in.
A list of all the indexed batches that have been arbitrated in the last 90 days is
displayed.

Note: You must be connected to the Internet to view the list.

4. Click a batch to review it.

You can click a column heading to sort the list. For example, to view the batches by
the results, click the column heading Arbitration Results.

Note: A result marked (?) indicates a batch that was marked "No extractable data,"
or "Blank image," or it was returned to be indexed again by the arbitrator. An arbitrator
may have returned the batch for the following reasons:

• A significant number of records or fields were skipped.
• Many fields had values contrary to the field help or project instructions.
• The values entered did not match what was on the image.
• An arbitrator accidentally returned the wrong batch to be re-indexed.

When a batch is returned, the original work is deleted, so there is nothing available
for you to review. A batch marked (?) does not reflect in the Arbitration Results
percentage score.
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Figure 3: Batch Review

5. View the information that you entered and the change the arbitrator made. Determine
why the change was made. The Field Help and Project instructions are available for
you to review.

• To view the next value that you entered that was changed by an arbitrator, click
Next.

• To return to a previous value, click Previous.
• To view a summary, click the Summary tab.
• To change the image size, use the Zoom in  or Zoom out  buttons. You can

also click the Reset (fit-to-width)  button or the Full Size  button.
• To rotate the image, use the Rotate Left  or Rotate Right  buttons.
• To move the image, click and drag the image.

There are many reasons why an arbitrator may have changed what you entered.

• There may have been a spelling error or differences of opinion in reading the
handwriting.

• The field help or project instructions may not have been followed.
• The wrong information may have been accidentally entered.
• The field or record may have been accidentally skipped.
• Blank information may not have been marked correctly.
• Unreadable information may not have been marked correctly.
• There may be some other guideline that was not followed.

6. If you feel that what you originally entered for a value was correct and the arbitrator
made a mistake, click Feedback.

• On the Feedback window, click Please Review.
• Click OK.
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7. When you are finished reviewing the batch, at the top, click Return to Batch List,
or close the browser window.

If you have questions, on the Arbitration Results tab, click Frequently Asked
Questions to view the questions and answers.

Indexing Links

You can easily access other helpful indexing information using the Indexing Links tab.

The Indexing Links tab allows you to easily view the following.

Indexing Resources

• Resource Guide: Resources for indexers, arbitrators, and group administrators, as
well as handwriting and language-specific helps.

• Indexing Tutorials: Help with getting started indexing, arbitrating, and
administering the indexing program in a stake or society.

• Ask a Question: Search a large knowledge base for answers to common questions.
• Familysearch Indexing Projects: A list of projects available for indexing.

If you have problems with these links, go to https://familysearch.org/indexing
and select an option.

FamilySearch Websites

• FamilySearch.org: The FamilySearch website (www.familysearch.org) provides
resources and information to help individuals with family history research. Click
Search to search for an ancestor and view the original records that you helped index.

• FamilySearch Indexing: Learn about and register to do indexing.
• FamilySearch Research Wiki: The Research Wiki provides information about

records and resources for family history research.

Indexing Steps

Indexing consists of a few simple steps.

You must sign in to the indexing program each time you want to start indexing.

1. On your desktop, click the FamilySearch indexing icon.

2. On the warning message, click Run.
A sign-in window will appear.

3. Enter your user name and password, and then click OK.
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Each time you sign in, the system checks and downloads any updates to the
FamilySearch indexing program.

4. If the Profile Information screen appears, add in the requested information.

DescriptionOption

For an LDS
Account: 1. In the Stake field, type the city, state, or country where you live,

or the name of the stake if you know it, and select it from the
list. Most stakes include the city or other geographical area as
part of the stake name. If you cannot find your stake listed,
contact FamilySearch Support at support@familysearch.org.

2. In the Ward field, type the ward.
3. In the Phone field, type your phone number.
4. Click Done.

For a
FamilySearch
Account:

1. Select one of the following groups:

• If you click Your country, select the country from the
drop-down list. For the United States, Canada, and United
Kingdom, select the state or province. Otherwise, type the
state, province, or district.

• If you click An LDS stake in your local area, type the city,
state, or country where you live, or the name of the stake if
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DescriptionOption

you know it, and select it from the list. Most stakes include
the city or other geographical area as part of the stake name.
Then enter your phone number. If you do not know the stake
name, click How?

• If you click Another group, select the group from the
drop-down list. Then enter your phone number.

2. If desired, you can select I do not want to select a group at
this time. You can select or change your group when you edit
your profile information.

3. Click OK.

5. If an important message appears, read the message, and then click Close.

6. On the Tip of the Day message, read the tip, and then click Close.

The FamilySearch indexing program's start page appears. You can now download a batch.

Note: If you have problems signing in, contact FamilySearch Support at
support@familysearch.org.

Batches are groups of one or more images that can often be indexed in 30-60 minutes.

Figure 4: Download a Batch

1. Click Download Batch.

A list of projects will appear.

• The highest priority project is highlighted in red.
• Projects are listed alphabetically by project name. To sort the list by language,

difficulty level, or points, click the column heading Description, Level, or
Points.

• To see all projects, at the top, click Show all projects.
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• To see only the projects that match your preference settings, at the top, click Show
preferred projects.

Note: If no projects match your preference settings, the list will be blank.

• To change your preference settings, click Edit My Preferences. Sign in to the
FamilySearch indexing website, and edit your preferences.

Note: If you edit your preferences, the list will close, and you will need to click
Download Batch again to see the updated list.

• To see what the images in a project look like, click a project, and then click View
Sample.

2. Click the name of the project you want to work on.

3. Select the number of batches you want to work on. You can have up to 10 batches
downloaded at one time.

4. Click OK.

Note: You can also double-click the name of a project to download a batch from that
project.

5. If someone else has worked on the batch you downloaded, but it was returned before
he or she could finish, you will see a message that this batch has been previously
indexed. Click OK.

Note: Indexers return batches for various reasons, or they may not have finished
before the due date and the system automatically retrieved the batch. Be sure to check
what the previous indexer has done. Then complete the batch as you would normally
index it.

6. Read the message about project instructions, and then click Close.

The document image or images are temporarily copied onto your computer.

If you do not see a project you would like to index, click Show all projects. You may
need to select a project you have not indexed before. Remember, you can read project
instructions, check the field help as you type, and contact others for support. You may
find indexing to be more enjoyable as you learn how to index different types of records.

Note: As a project nears completion, there may be no batches available to download
for that project. If batches are returned, the project may appear and disappear as these
final batches are completed.

Read the project-specific instructions before indexing or arbitrating a project. These
instructions provide background, guidelines, and examples that need to be followed for
each project.

Click the Project Instructions tab on the right side of the data entry area.

Some projects may have the instructions on the tab. Read the instructions. There
may be links to more information at the bottom.

Note: If you scroll to the end of the instructions, there should be a link to Project
updates. These updates provide answers to questions that occur after a project is
available for indexing. You can recheck these project updates for the latest information
about indexing a project.

You can also find project updates using Ask a Question. When you search for an
answer, type the name of the project, and then type updates, such as Trento Italy
Baptism Records updates.
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A record is created for each principal name on a document image. Some batches have a
set number of records on each image and will have a corresponding number of data
entry lines already set up. For other batches, you will need to determine the number of
records to add the needed data entry lines.

The project instructions will tell you about how many records there are per image. Review
the instructions. Then look over the document image to determine how many records
are included on that image. Change the number of records, if needed. This will adjust
the number of lines in the data entry area to enter the information.

1. Count the number of records on the image. Do not count any blank lines, unless the
project instructions specify differently.

2. On the menu bar, click Tools, and then click Records per image.

3. Type the number of records, or click the up or down arrow to select the number
of records on this image.

4. If your batch has more than one image and each image has the same number of
records, click Apply to all images.

5. Click OK.

The number of data entry lines will change to the number of records you set. You may
need to adjust the number of records again for each image. If needed, you can add,
insert, or delete records as you index.

Note: If the number of data entry lines does not change, this indicates that this batch
has a minimum number of records that must be accounted for. The unused lines must
be marked as blank before you can submit the batch.

Certificate Documents

Certificate-type documents usually contain information for one individual. Each
certificate becomes a record.

There may be more than one certificate on each image. Sometimes there are certificates
below or to the side of the one you initially see on the screen. The project-specific
instructions may also specify if there is more than one certificate on an image. Use the
scroll bars, click and drag the image, or click and drag the gray highlight in the Image
Navigation tab to check the entire image for the number of records before beginning to
index.

Register Documents

Register, ledger, and census-type documents contain information about many people
all on the same image. The information is organized in rows and columns. Usually each
row represents one individual, or one record.
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A batch may have more than one image, with each image having several rows or records.
An image may also have more than one page. Use the scroll bars, click and drag the
image, or click and drag the gray highlight in the Image Navigation window to check
how many individuals or records are listed on the image.

Image and Record Numbering

The numbers on the left of the data entry area associate each record with the image.

Batches with one certificate on each image will have two numbers on each line. The
number on the left represents the image, and the number on the right represents the
record for that image, such as 01-01, 02-01, 03-01, and so forth.

Note: Click the image number to jump to that image in the batch.

Batches with more than one certificate on an image or several records on an image will
also have two numbers. The number on the left represents the image, and the numbers
on the right represent the records for that image, such as 01-01, 01-02, 01-03, and so
forth. These numbers may not necessarily match the line numbers on the document
image.

At the bottom of the screen, you can also see what image or record you are currently
viewing.

Add a Record

While indexing, if there is an additional individual on an image, you can add a record
to the data entry area as needed.

To add a record at the bottom of the list, click the Add Record  button.
A record will be added at the end. You can now type the information for this
individual.
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Insert a Record

While indexing, if you notice you skipped an individual on an image, you can insert a
record in the data entry area as needed.

1. Click on the record just below where you want to insert the missing individual.

2. Click the Insert Record  button.
A record row will be inserted before the one currently selected. The record numbers
on the left will be adjusted.

Delete a Record

While indexing, if there are no more individuals on an image but you have an extra
record line, you can delete the record in the data entry area.

1. Click on the record to be deleted.

To delete multiple record lines, click on the first record to be deleted. Hold down the
Shift key, and click on the last record to be deleted. This will highlight several record
lines.

2. Click the Delete Record  button.
The record line will be deleted.

Note: If deleting a line reduces the number of records below the minimum for this
project, the line is not deleted. The unused line must have data entered or be marked
as blank before you can submit the batch.

Enter the information requested in the data entry area.

As soon as the batch is downloaded, the first image appears on the top part of the
indexing screen. On the bottom part is the data entry area.

Each item of information is referred to as a “field.” Required fields list <Required> in the
field. Required fields must be filled in or marked as blank. Where possible, the fields in
the data entry area are labeled to match the labels used on the original document.
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Figure 5: Indexing Screen: Note required fields

1. Click on the first field to start typing the information from the document image.

2. To advance to the next field, press Tab or Enter.

When you are on the last field of the record and advance to the next field, the record
is automatically saved, and the cursor advances to the first field of the next record.

Tip: You have several data entry aids to help as you enter information. Under Help,
see information about:

• Adding diacritics or other characters.
• Copying information from a previous field or record.
• Using the lookup list.
• Marking blank fields and records.
• Indexing unreadable fields and records.

You can also make several adjustments to the Indexing screen to help view the image
or data entry area better. Under Help, see information about:

• Adjusting the image brightness and contrast.
• Adjusting the text size.
• Adjusting the size of the image.
• Showing the next or previous image.
• Using highlights or the ruler.

Make sure you scroll all the way to the right and all the way to the bottom to ensure
you have indexed all the names on the image. Some images are large and may have
two document pages in the image. Under Help, see information about:

• Moving around the image.
• Adjusting the zoom.

3. When you are at the end, a message will ask if you want to do the quality check.
Click Yes.
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As you enter data, any information that does not match an entry in the lookup list
appears with a red wavy line or colored background. This is not an indication that you
made a mistake. The lookup lists are limited and may not include every variation in
spelling, particularly for names. The lists are intended as a guide to help you interpret
the data. During the quality check, you recheck any data marked with a red wavy line
or colored background. You may change the data or indicate that what you entered is
correct. To indicate that the value you entered is correct before doing the quality check,
click in the field, and press Ctrl+T.

Header Data

The Header Data tab has fields that apply to all the records on an entire image. For
example, on U.S. census batches, the document type, county, sheet number, and sheet
letter fields appear on the Header Data tab and are entered only once. The rest of the
fields to be indexed appear on the Table Entry or Form Entry tabs.

The fields on the Header Data tab vary, depending on the project. For example, a census
may include the image type, county, sheet number, and sheet letter. If the document
image does not include any header data fields, this tab will not appear.

If the batch has more than one image, enter the information on the Header Data tab
for all the images first. To move to the next image, on the left, click the next image
number, such as 01, 02, and so forth. This gives you the opportunity to check each image
of the batch before indexing. Then you can move to Table Entry or Form Entry and enter
the other information.

Note: If the program does not automatically advance to Table Entry after filling in the
Header Data tab, it is because there are more images that need Header Data filled in.

Image Type Field

The Image Type field is a required field. It appears on either the Header Data tab or as
the first field in the record. Click in the field, and then click the drop-down arrow to
select an item from the list that describes the image.

You will need to select the image type for each image in a batch before indexing the
information from the images. If there are several images in a batch, to move to the next
image, on the left, click the next image number, such as 01, 02, and so forth.
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• For projects with more than one image per batch, the field may appear on the Table
Entry or Form Entry tab.

• For projects with only one image per batch, the field will usually appear on the Header
Data tab.

When to Use the TypeImage Types

The image has the requested information to index.Normal

The image is blank or is a form with no information
filled in. (The header at the top of the form may have

Blank Image

some information, but the image has no records to in
dex.) On the warning message, click Yes. This will mark
all the fields with “<blank>.” If there is not another im
age to index, submit the batch. (Do not return the
batch.)

The image is an exact duplicate of a previous image in
the same batch, usually the image immediately preceding

Duplicate Image

the duplicate. (The image was filmed twice.) Index the
image that is easiest to read, and mark the other image
as a duplicate. On the warning message, click Yes. Finish
indexing other images, and then submit the batch. (Do
not return the batch.)

Note: If the image is a duplicate of a previous page in
another batch, index the image in your batch. Do not
mark it as a duplicate. If the surname is missing and you
cannot view it, such as in a census record, mark the
surname as blank.

If the whole image is too light, too dark, or too damaged
for you to index any of the required information, select

Unreadable Image

this option. On the warning message, click Yes. Howev
er, if some of the image is readable, such as a torn page,
mark the Image Type as Normal, index what you can
see, and mark the missing required fields blank.

The image contains extra information added by the
camera operator, such as title boards or markers, or

No Extractable Data Im
age

other information included with the documents, such
as a table of contents. The image does not have any
records for you to index. This would include an index
page, with names and page numbers, or pages with in
formation that is not requested. After selecting this op
tion, on the warning message, click Yes. However, if an
index includes vital information, such as names, dates,
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When to Use the TypeImage Types

and places, mark the Image Type as Normal, index what
you can see, and mark the missing required fields blank.
Finish indexing other images, and then submit the
batch. (Do not return the batch.)

Note: For some projects, the image type is already set and cannot be edited.

Note: When blank, duplicate, unreadable, or no extractable data is selected, that
information is placed in all the fields for all the records for that image. If you decide

that this is not the case, click the Undo  button to retrieve any data that may have
been replaced, and select a different item in the Image Type field.

Table Entry

In Table Entry view, the fields to be indexed are listed horizontally in columns across
the top of the data entry area. Each row represents a separate record. If there are more
fields to be indexed than can fit on the screen, the table will scroll to the right.

Form Entry

In Form Entry view, the fields to be indexed are listed vertically one below another. All
the fields are for one record. When you advance to the next record, a blank form appears.

Any project that has Table Entry available will also have Form Entry as an option. To
change the entry view, click the appropriate tab in the data entry area. Projects that have
more than one record type, such as those with both baptisms and marriages, are set up
in Form Entry only.

Before you submit a batch, you must do a quality check on the information you entered.

As you enter data, any information that does not match the lookup list appears with a
red wavy line or colored background. This is not an indication that you made a mistake.
The lookup lists are limited and may not include every variation in spelling, particularly
for names. The lists are intended as a guide to help you decipher information that is
difficult to read. During the quality check, the system prompts you to recheck any data
marked with a red wavy line or colored background. You may change the data or indicate
that what you entered is correct.

When you are finished indexing data, the Quality Checker window replaces the Field
Help window on the right side of the data entry area. The first marked field appears,
along with an explanation of why the data needs to be rechecked. A congratulations
message appears. After reading the message, click Close to start the quality check. If the
Quality Checker does not appear, click the Quality Checker tab. The quality check
looks at any fields marked with a red wavy line or colored background and at any required
fields that are left blank.

Note: You can click the Quality Checker tab at any time to check marked names. You
do not have to wait until you are finished.
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Figure 6: Quality Check

1. Recheck the information you typed with what you see on the image.

• To keep what you entered, click Accept.
• To keep what you entered for the same field in all records, click Accept All.
• To change what you entered, type the new data in the field.

Note: If the value you enter is not in the Lookup list, the quality checker may
present this field again. You can then click Accept to keep what you entered.

• To change what you entered for the same field in all records, type the new data
in the field, and click Change all to new value. On the confirmation message,
click Yes.

2. When you click an Accept or the Change all to new value button, the quality
checker automatically moves to display the next field with a red wavy line or colored
background.

Note: You may also click Next to go to the next marked field.

3. To return to a previous decision, click Back.

4. Once all the marked fields have been approved or changed, the quality check will
check for blank required fields. If a required field was left blank, do one of the
following.

• If there is no information listed on the image, click Accept. This places the term
<Blank> in the field.

• If there is information listed on the image, type the information in the field, and
click Next.

5. When the quality check is finished, on the message to submit the batch, click Yes.
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When you have finished indexing a batch, you need to submit it. When you submit a
batch, the information is saved on the server, and the system removes the images and
information from your computer.

1. After the quality check is complete, a message appears asking if you want to submit
the batch. Click Yes.

If you did not do the quality check, the system will automatically start the quality
check process before submitting the information. If there are no fields to check, the
batch will be submitted.

Note: You can also click the Submit  button, or click the File menu, and click
Submit. On the FamilySearch indexing start page in the My Batches section, you
can also click the batch, and then click the Submit Batch button.

2. On the Batch successfully submitted message, click OK.

Once you submit a batch, it is considered finished. You cannot retrieve it to fix a mistake.
However, each batch is indexed twice, by an A indexer and a B indexer, and if there are
differences, the batch is viewed by an arbitrator, who will fix errors. Once an arbitrator
has submitted a batch, it is considered finished.

Saving Your Work

You can save your work and return later to complete a batch. The batch will appear on
your FamilySearch indexing start page when you access the program again.

When you save a batch, the information is saved to your computer and to the server.
When you save the batch to the server, the information you entered can be accessed
from a different computer.

Note: If you are working on the same batch on two different computers, you may need
to retrieve the saved information from the server to view data you entered on a different
computer.

If you are working online, when you press Tab or Enter on the last field of a record,
the record is automatically saved. If you are working online, information is also
automatically saved when you close the indexing program or return to the indexing
start page. Therefore, if the batch due date occurs and the batch is retrieved by the system
before you can finish the batch, the information is not lost. However, it may be lost if
you are working offline and do not save the information to the server before the due
date.

1. If you are working offline and want to save to the server, reconnect to the Internet.
Return to the indexing start page, click the drop-down list, and select Work
Online.

2. Reopen the batch, and click the Save  button.

Note: You can also click the File menu, and click Save.

Returning to the Start Page

From the indexing page, you can return to the FamilySearch indexing start page.
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At the top left, click Close and Return to Start Page.

The FamilySearch indexing start page with the My Batches section appears.

Opening a Previously Downloaded Batch

If you saved your work, you can return at a later time to finish a batch.

You have seven days in which to finish a batch. The due date is listed in the My Batches
section. The system will warn you when a batch is about to expire. If you cannot finish
the batch, after seven days it will automatically be retrieved by the system and assigned
to the next indexer who requests a batch for that project.

Figure 7: My Batches section

1. In the My Batches section of the FamilySearch indexing start page, double-click the
batch you want to work on.

Note: You can also click on the batch, and then click the Work on Batch button.

2. If you are working from a different computer and do not see the previous information
you entered, click the File menu, and click Retrieve from Server.
Information that you typed on another computer and saved to the server may not
be visible until you retrieve it from the server. Information that you typed on the
same computer will display.

Returning a Batch

If after viewing a batch you realize that you will not be able to work on the batch, either
because it is difficult to read or for any other reason, you may return the batch.

There are a few situations you may see that are difficult to determine whether to return
a batch or not.

• If part of a page is torn off, there is nothing that we can do about a torn page. Index
what you can, and mark missing required fields blank.

• If part of a page is missing, but not because of a torn page, return the batch, and select
the option Review Image Quality.

1. Click the File menu, and click Return Batch.

Note: On the FamilySearch indexing start page in the My Batches section, you can
also click the batch, and click Return Batch.

2. On the Return Batch window, click one of the following options:
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To return a batch so it may be indexed by another indexer, click Give to Other
Indexers. Any work you have already completed will not be lost. The batch will
be available for another indexer to download.

•

• To indicate that the image has a problem and should be reviewed by an
administrator, click Review Image Quality. The batch will be taken out of
circulation. An administrator will review the image.

Working Offline

When you download a batch, the image is saved to your computer. If needed, you can
disconnect from the Internet to work on the batch offline. Then when you are done,
you can reconnect to the Internet to submit the batch.

Switching between offline and online modes does not disconnect you from or reconnect
you to the Internet.

Note: The Download From, Submit Batch, or Return Batch buttons are not available in
offline mode.

1. After you have downloaded the batch, click the drop-down list, and select Work
Offline.

Note: If you downloaded multiple batches, first open each batch, and wait for the
message “Download Complete” in the bottom right corner of the screen before clicking
Work Offline. You will then be able to view a previous page if necessary.

2. Disconnect from the Internet.

3. Work on the batch.

4. When you are done with the batch, reconnect to the Internet.

5. Return to the indexing start page, click the drop-down list, and select Work
Online.

6. If you need to stop working on the batch and return later, click the Save  button.

Note: If you are connected to the Internet and working online when you save, the
information is saved to the server.

Now that you are reconnected to the Internet, you can submit the batch.
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Chapter 2

Participating in FamilySearch
Indexing

Over 100,000 volunteers index about one million names per day with FamilySearch
indexing. To ensure the best quality, each document image is looked at three times. First,
it is indexed by two different people, indexer A and indexer B. The system compares the
two versions, and if there are any differences, it is sent to a third person, an arbitrator, to
review.

FamilySearch indexing has several advantages.

• The indexed information is available free on www.familysearch.org.
• All document images that are free of restrictions will also be free to the public.
• Qualified volunteers will have free access to some affiliate images under contract, not

just the collections a volunteer helps to index.
• With 15 high-speed scanners digitizing 2.4 million rolls of microfilm from its current

collection and more than 200 digital camera teams filming new records daily, there is
a greater variety of projects for volunteers to help with.

• FamilySearch indexing is available in several languages, making this a world-wide effort
to provide indexes to records.

• FamilySearch International continues to work with genealogical and historical societies
world-wide in a collaborative effort to provide quality indexes to more records.

What Is Indexing?

In FamilySearch indexing, volunteers copy family history information from digital images
of documents.

The indexing process is simple.

1. Genealogical documents from around the world are converted into digital images
and stored on the FamilySearch system.

2. Each document is divided into small batches of about 20-50 names.
3. An indexer downloads the images to his or her computer and enters the requested

information.
4. Each batch of documents is indexed by two different people to ensure accuracy. This

is referred to as the A indexer and the B indexer.
5. If information from the A indexer does not agree with information from the B indexer,

then someone called an arbitrator will review both versions, compare them with the
original document, and make the needed changes.

6. Everyone gets free access to the indexes at www.familysearch.org.
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Who Decides What Will Be Indexed from an Image?

A project manager decides what information is to be indexed.

The decision is based on the following:

• The contract with the record custodian.
• The plans for the index.

If volunteers indexed all of the information on an image, projects would take too long
to finish. Important information such as names, dates, and places are indexed. Because
this is an index to help individuals find their ancestors, an individual can see the other
information on the actual image.

Viewing Indexed Information

When an indexing project is completed, it is made available on the FamilySearch website.

1. Go to: familysearch.org
2. At the top, click Search.

3. Enter the information about your ancestor, and click Search.

4. To search a specific record collection or project or to see a list of all the record
collections available, below the search area, click Browse All Published
Collections, and select the region and record collection to search.
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What Is an Indexing Project?

An indexing project is a record or a record collection that centers around a specified
place or time range, such as the U.S. 1910 census or Ohio death certificates.

There are two types of projects:

• FamilySearch projects that any volunteer can help index.
• Partner projects that use FamilySearch indexing services but are managed by another

genealogical or historical society. FamilySearch indexing works with other societies
to complete projects of mutual interest. Some of these groups accept volunteers to
help index the records. Some groups, however, may want to keep the indexing within
their group or within a certain region to get the historical or language expertise they
desire.

Viewing Information About a Project

You can view information about projects on the FamilySearch indexing website.

1. Go to: familysearch.org/indexing
2. Click Find a Project.

Or, in the FamilySearch indexing program, on the My Batches page, click the
Indexing Links tab, and click FamilySearch Projects.

A list of available projects is displayed.

3. Click the name of the project you are interested in.

Can You Tell Me About Future or Upcoming Projects to Index?

Information about upcoming collections is not made available prior to posting for
indexing due to various factors, such as finalizing agreements with genealogical societies
or archives about the indexing, final assembly considerations, or space on the servers.

You can select a project that interests you or matches your skill level, language, or type
of record. You cannot select a specific locality within a project, such as a county within
the 1910 New York census.

Can I Request That Records from a Specific Area Be Indexed?

At this time, FamilySearch indexing cannot accommodate individual requests for specific
areas or specific records to be indexed.

Getting Started

Starting FamilySearch indexing is very easy.

To get started with FamilySearch indexing, you need to do the following:

• Download the indexing program.
• Register for an account.
• Sign in to the indexing program and download a batch.
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Who Can Index?

Anyone who would like to participate is welcome to index records. You do not need to
be a member of The Church of Jesus Christ of Latter-day Saints.

The age for indexing is over 13. If indexers are between the ages of 13 to 18, their parent
or legal guardian must consent to their participation.

Trying Indexing before You Register

You can see what indexing looks like before registering for FamilySearch indexing.

1. Go to: familysearch.org/indexing
2. To see what indexing looks like, click Test Drive.

3. Type the information requested into the fields.
The red boxes provide instructions to help you. After you enter information in a field,
the system will give immediate feedback on whether the information is correct.

Note: The immediate feedback exists only in the test drive. It is not available when
you index.

What Is a Batch?

Each project or record collection is divided into batches of one or more images that
contain around 20-50 names.

When you index, you download a batch to work on. The batch may be just one image
with several names, such as a census page. Or a batch may be several images with one
or more names per image.

Batches or record images vary in their difficulty to index. When you start indexing, you
will be given a "starter" project with a very easy batch. After submitting the starter batch,
you may then select from one or more beginning level projects to index.

As you become more familiar with indexing and reading records, you can select
intermediate and advanced level projects to index. You can select the project difficulty
level and languages you would like displayed in your preferences.

Starting to Index for the First Time

To get started with indexing, you download the indexing program, register, and sign in.

All users must now register and use a FamilySearch or LDS Account. With this account,
you use the same user name and password to sign in to several FamilySearch websites.
For members of The Church of Jesus Christ of Latter-day Saints, the LDS Account provides
access to not only FamilySearch websites but also other Church websites.

1. On the FamilySearch indexing website familysearch.org/indexing, click Get
Started.

2. Click Download.

Note: The website automatically determines what operating system you have and
downloads the appropriate version of the program for your operating system.
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3. The steps for downloading the program vary slightly, depending upon your browser.

StepsBrowser

Internet Explorer
1. On the “Do you want to run or save this file” message, click

Run. A download progress bar appears.
2. On the security warning message, click Run. A download

progress bar appears.

Mozilla Firefox
1. On the save file message, click Save File. A download

progress bar appears.
2. On the Download window, click Open.
3. On the “open executable file” message, click OK. An install

progress bar appears.

Google Chrome
1. At the bottom of the screen, on the “are you sure” message,

click Save.
2. At the bottom of the screen, click the indexing program

listed.
3. On the security warning message, click Run. A download

progress bar appears.

Macintosh Safari
1. On the Indexing window, double-click the FamilySearch

Indexing Installer icon.
2. On the “are you sure” message, click Open.

4. On the Welcome to FamilySearch Indexing Setup Wizard, click Next.

Note: An install progress bar appears as the program is installed on your computer.

5. Select the language files to include.
This includes the language for the help files.

6. On the Completing the FamilySearch Indexing Setup Wizard, click Finish.

Note: The indexing program places a FamilySearch indexing icon on your computer's
desktop. To sign in to indexing in the future, double-click this icon.

7. You may already have a FamilySearch or LDS Account if you have registered for
another program that uses these accounts. Users who already have a FamilySearch
or LDS Account will not need to register again. If you have not yet registered for this
account, on the sign-in window, click Register for a New Account.
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8. After you have registered, sign in by entering your user name and password, and click
OK.

Each time you sign in, the system checks and downloads any updates to the
FamilySearch indexing program.

9. The first time you sign in, a liscense agreement appears. Read the license agreement,
and click the box next to I agree, and then click OK.

10. On the Profile Information screen, add in the requested information.

StepsOption

For an LDS
Account: 1. In the Stake field, type the city, state, or country where you live,

or the name of the stake if you know it, and select it from the
list. Most stakes include the city or other geographical area as
part of the stake name. If you cannot find your stake listed,
contact FamilySearch Support at support@familysearch.org.

2. In the Ward field, type the ward.
3. In the Phone field, type your phone number.
4. Set your preferences for e-mail messages by checking or

unchecking the options.

• General updates may include notices about new records
available to index, records finished and available to search, or
other general news.

• Account messages includes milestone notices, such as you've
indexed 200 batches.

5. Click Done.

For a
FamilySearch
Account:
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StepsOption

1. Select one of the following groups:

• If you click Your country, select the country from the
drop-down list. For the United States, Canada, and United
Kingdom, select the state or province. Otherwise, type the
state, province, or district.

• If you click An LDS stake in your local area, type the city,
state, or country where you live, or the name of the stake if
you know it, and select it from the list. Most stakes include
the city or other geographical area as part of the stake name.
Then enter your phone number. If you do not know the stake
name, click How?

• If you click Another group, select the group from the
drop-down list. Then enter your phone number.

2. If desired, you can select I do not want to select a group at
this time. You can select or change your group when you edit
your profile information.

3. Set your preferences for e-mail messages by checking or
unchecking the options.

• General updates may include notices about new records
available to index, records finished and available to search, or
other general news.

• Account messages includes milestone notices, such as you've
indexed 200 batches.

4. Click OK.

11. If an important message appears, read the message, and then click Close.

12. You can view a quick start demonstration on how to index. Click Play Video. When
you are finished with the video, click the red X to return to the FamilySearch indexing
program.
The FamilySearch indexing program's start page appears.

13. On the Tip of the Day message, read the tip, and then click Close.

14. Click Download Batch.
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For the first time, one starter project is listed. If no projects are listed, there is not a
starter project available in your language. Click Show all projects.

15. Click the name of the project to highlight it, and then click OK.
A batch with only one image is downloaded.

16. Read the message about project instructions, and then click Close.

17. To read the project instructions, click the Project Instructions tab on the right
side of the data entry area.

18. Type the information requested from the image.

If you have questions about what to type, click the Field Help tab, and read the
instructions for what to type in the field.
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19. After the batch is finished, a message appears to let you know that the quality check
will begin checking for entries that are not consistent with the Lookup lists. Click
OK.

20. After the quality check is done, a message indicates that you are ready to submit the
batch. Click Yes.
The next time you download a batch, beginning level projects will be listed.

As a new indexer, you will receive an e-mail listing training, help, and support available
for indexing.

Registering For and Maintaining Your FamilySearch
Account

A user can register and set up his or her own account with a user name and password.

Registering for an Account

Registering for a FamilySearch account is free and secure. Your information will not be
shared or sold.

FamilySearch uses the same username and password as the following websites. (If you
have already registered for any of the following sites, you may proceed to sign in using
the same username and password. Additional registration is not needed.)

• LDS Church website (lds.org)
• The Church's stake and ward websites (secure.lds.org/units)
• FamilySearch (familysearch.org)
• FamilySearch Research Wiki (wiki.familysearch.org)

Although anyone over the age of 13 may create an account, we encourage all minors to
seek parental permission before they proceed in creating an account. Children ages 8-12
may create an account only if parental consent is given during the registration process.

To register, follow these steps:

1. On the FamilySearch indexing Sign In screen, click Register for a New Account.

2. Fill in your basic information:

a. Enter your first name.
b. Enter your last name.
c. Choose a username.

A username must meet the following requirements:

• It must be 4 to 64 characters long.
• It cannot have spaces or periods.

Usernames are not case sensitive. It does not matter if you type it as uppercase or
lowercase letters.

Though Japanese, Chinese, or Korean characters are allowed, it is strongly
recommended that you use roman characters.

d. Choose a password.

Passwords must contain at least eight characters. At least one character must be a
letter, and at least one must be a number.
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e. (Optional) Upload a photo of yourself.

3. Enter either an active email address or mobile phone number.

This information is used to verify your account.

4. Create a contact name.

The system uses your contact name when it lists you as the contributor of information
to Family Tree and other places in the website.

Your contact name can have characters from any language.

Your contact name may be your real name or a made-up nickname.

5. Fill in additional information.

6. If you are a member of The Church of Jesus Christ of Latter-day Saints, enter your
membership information:

a. After the question that asks whether you are LDS, click Yes.
b. If you have it, enter your membership record number (MRN). If you do not have

it, click Don't know your MRN? Remind me later.

You can get this number from your ward or branch membership clerk.

7. Agree to the Terms of Use.

8. Click Create Account.

What happens next depends on whether you entered an email address or mobile
phone number:

• If you entered an email address, an email is sent to your inbox. That email contains
a link that you can use to verify your account.

• If you entered a mobile phone number, you receive a text message with a
verification code. On the screen, a window appears in which you can enter that
code.

9. Verify your account:

• If you used email as your verification method, go to your inbox, open the email,
and click the link that is provided to verify your account.

• If you used text message as your verification method, open the text message that
was sent to your mobile phone. Online, enter the code provided in the text message
into the Enter Verification Code box.

Your account is created. You can sign in using the username and password that you
entered.

Can I Create More Than One Account?

If you would like to see different projects, such as working with partner projects, you
can create more than one FamilySearch Account.

For LDS Church members, you can have only one LDS Account. However, you can create
as many FamilySearch Accounts as you need to index various projects. When you create
another account, you must modify one of the following:

• First name
• Last name
• E-mail address

For example, you can add or delete an initial or middle name for your first name.
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Retrieving a Forgotten User Name

The steps for retrieving a forgotten user name vary, depending on whether you have a
FamilySearch Account or an LDS Account.

Retrieving a Forgotten User Name from a FamilySearch Account

A forgotten user name can be sent in an e-mail.

1. On the sign in window, click Forgot user name.

2. When the system asks which type of account you have, click FamilySearch
Account.

3. Enter your e-mail address.

4. Type the letters displayed in the picture. Type them as lowercase letters with no
spaces.

5. Click Retrieve.
A message indicates that your user name has been e-mailed to you.

6. Open your e-mail program, and locate the e-mail that helps you recover your user
name.
Your user name is listed in the e-mail.

7. Click the button to return to the program that you were trying to sign in to.

Retrieving a Forgotten User Name from an LDS Account

A forgotten user name can be sent in an e-mail.

1. On the sign in window, click Forgot user name.

2. When the system asks which type of account you have, click LDS FamilySearch
Account.

3. Click Continue.

4. Enter the e-mail address that is associated with your account.

If you no longer have that e-mail address or do not remember it, follow these steps:

a. Click I don’t have/remember my e-mail.
b. Click Yes to indicate that you are a Church member. Fields appear where you can

enter your membership record number and birth date.
c. Enter your membership record number.

If you do not know this number, you can get it from your ward or branch clerk.

d. Enter your birth date.
e. Type the letters displayed in the picture. Type them as lowercase letters with no

spaces.
f. When the system displays your name and birth date, click Yes to indicate that it

is you.
The system shows the e-mail address that is associated with your LDS FamilySearch
account.

g. If you still have this e-mail account, click Keep E-mail Address. The system
returns you to the screen where you enter your e-mail address. Enter your e-mail
address, and continue to recover your user name.

h. If you do not still have this e-mail account, click Change E-mail Addresses,
and enter your new one. An e-mail is sent to the address you listed. Click the link
in this e-mail within 48 hours to activate your account. If you wait longer than
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48 hours, you will need to redo the registration process. Open your e-mail program,
and locate the e-mail message that lets you complete your registration. Click the
Complete Registration link indicated in the e-mail message. After you have
validated the e-mail address, begin again the process of retrieving your user name.

5. Type the letters displayed in the picture. Type them as lowercase letters with no
spaces.

6. Click Recover My User Name.
A message indicates that your user name has been e-mailed to you.

7. Open your e-mail program, and locate the e-mail that helps you recover your user
name.
Your user name is listed in the e-mail.

8. Click the button to return to the program that you were trying to sign in to.

Retrieving a Forgotten Password

The steps for retrieving a forgotten password vary, depending on whether you have a
FamilySearch Account or an LDS Account.

Retrieving a Forgotten Password from a FamilySearch Account

If you forgot your password, you can create a new password.

1. On the sign in window, click Forgot password.

2. When the system asks which type of account you have, click FamilySearch Account
(for the general public).

3. Enter your user name.

4. Type the letters displayed in the picture. Type them as lowercase letters with no
spaces.

5. Click Retrieve Password.
A message indicates that an e-mail containing instructions for resetting your password
has been sent.

6. Open your e-mail, and locate the e-mail that lets you recover your password.
The e-mail contains a link that you can click to reset your password.

7. Click the link in the e-mail.
You see a screen in which you can enter a new password.

8. Enter a new password.

The password must have at least eight characters with at least one letter and one
number.

9. Enter your password again.

10. Click Save Password.
A message indicates that your password has been changed.

11. Click the button to return to the program that you were trying to sign in to.

Retrieving a Forgotten Password from an LDS Account

If you forgot your password, you can create a new password.

1. On the sign in window, click Forgot password.
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2. When the system asks which type of account you have, click LDS FamilySearch
Account (LDS Account for members of The Church of Jesus Christ of
Latter-day Saints).

3. Click Continue.

4. Enter your user name, and click Continue.

5. Enter the answers to the security questions, and click Submit Answers.

6. If you listed both a second email and a mobile phone number, indicate whether to
recover your password by email or mobile phone. Then click Continue.
You will receive either an email or text message.

7. Follow the appropriate steps:

DescriptionOption

You are recovering your
password by email. 1. Open your email program, and locate the email

for your account.
2. Click the link in the email to reset your password.

You are recovering your
password by mobile phone. 1. Open the text messages on your mobile phone

and locate the message for your account.
2. On your computer, enter the verification number

listed in the text message, and then click Verify.

8. Enter a new password.

The password must have at least eight characters with at least one letter and one
number.

9. Enter your password again.

10. Click Update.
A message indicates that your password has been changed.

11. Click the button to return to the program that you were trying to sign in to.

Editing Profile Information

You can edit your personal information, including your e-mail address. You can also
add a local LDS stake or other group to receive local support.

Information is divided into two types:

• FamilySearch Account Information: This includes your name, user name, display
name, and e-mail address. This information is common for all FamilySearch programs.

• Additional Indexing Information: This includes your group information, address,
roles, and history. This information is used only with the FamilySearch indexing
program.

The steps for changing your FamilySearch account information are different for those
with an LDS Account.

1. Click the Tools menu, and click Options.

2. Click the Personal Information tab, and then click Change My Information.

3. Type your user name and password, and click Sign in.
Your information is displayed.
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4. If you have an LDS Account and want to change your account information, click
Edit above Information.

a. Type your user name and password, and click Sign in.
b. Click Edit.
c. To change a piece of information, delete what is currently in the field. Then enter

the new information.
d. Click Update.

If you change your primary or alternate e-mail address, the system sends an e-mail
to the new address. This extra step helps make sure that you entered the e-mail
address correctly and that you own it. You have 48 hours to open the e-mail and
click the link that validates the e-mail address.

You can change one e-mail address at a time. After you validate the first e-mail
address, you can change the second one.

e. Click Sign Out at the top right to close the LDS Account.
f. Click the Back arrow at the top left to return to the My Information page.

5. For all other changes, click Edit.

6. Type any changes to your information.

If you change your e-mail address, the system sends an e-mail to the new address.
This extra step helps make sure that you entered the e-mail address correctly and that
you own it. You have 48 hours to open the e-mail and click the link that validates
the e-mail address.
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7. For those with an LDS Account, if you are moving, or if you need to change your
stake or ward, do the following:

a. In the LDS Stake field, type the stake name, or the name of the city or state, and
select it from the list.

If you cannot find your stake listed, contact FamilySearch Support at
support@familysearch.org.

b. In the Ward field, type the ward.

8. For those with a FamilySearch account, if you want to select or change your group,
in the Local Support Level, select one of the following from the list:

• If you click Country, select the country from the drop-down list. For the United
States, Canada, and United Kingdom, select the state or province. Otherwise, type
the state, province, or district.

• If you click LDS Stake, type the stake name, or the name of the city or state, and
select it from the list. If you are not sure which LDS stake is the closest, ask a local
LDS church member for his or her stake name, or contact a local family history
center. You can locate family history centers on www.familysearch.org.

• If you click Group, select the group from the drop-down list.

9. Click Save.

If you have added an LDS Stake, the stake indexing director or group administrator will
be listed as your local support administrator. In the indexing program, click the Help
menu, and click Contact Support to view the administrator's contact information.
You can contact the administrator for questions or help. Other groups may or may not
have a group administrator.

Indexing Groups

Indexing groups allow you to be part of a community of indexers who are either in your
geographic area or have a common interest. Belonging to a group may provide access
to additional help and support and other opportunities, such as indexing projects that
are restricted to a specific locality. You can join only one group per indexing account.

There are three types of indexing groups:

• Country: Indexers in a country group are eligible for indexing projects that are
restricted to a specific locality. Most groups, however, do not have a group
administrator to provide additional help or support.

• LDS stake: This option adds you to a group of indexers within a local area called a
“stake.” LDS stakes have a stake indexing director or group administrator who can
provide local training and support. Indexers in stakes are also eligible for indexing
projects that are restricted to a specific locality. You do not have to be a member of
The Church of Jesus Christ of Latter-day Saints to belong to an LDS stake group, nor
will selecting this option begin any missionary activity.

• Group or Society: This option adds you to a group of indexers who have a common
interest, such as a language, family group, or other interest. The group may have an
administrator who can answer questions or provide additional support. To request a
new group, contact FamilySearch Support at support@familysearch.org.

If the group has a group administrator, that person will be listed as your local support
contact. In the indexing program, click the Help menu, and click Contact Support
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to view the administrator's contact information. You can contact the administrator for
questions or help.

Changing a Password

The steps for changing a password vary, depending on whether you have a FamilySearch
Account or an LDS Account.

Changing a Password with a FamilySearch Account

You can change your password.

1. From the My Information page, click Change Password.

2. When the system asks which type of account you have, click FamilySearch Account
(for the general public).

3. Enter your user name.

4. Type the letters displayed in the picture. Type them as lowercase letters with no
spaces.

5. Click Retrieve Password.
A message indicates that an e-mail containing instructions for resetting your password
has been sent.

6. Open your e-mail, and locate the e-mail that lets you recover your password.
The e-mail contains a link that you can click to reset your password.

7. Click the link in the e-mail.
You see a screen in which you can enter a new password.

8. Enter a new password.

The password must have at least eight characters with at least one letter and one
number.

9. Enter your password again.

10. Click Save Password.
A message indicates that your password has been changed.

11. Click Close This Browser.

Changing a Password with an LDS Account

You can change your password.
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1. From the My Information page, click Change Password.

2. When the system asks which type of account you have, click LDS FamilySearch
Account (LDS Account for members of The Church of Jesus Christ of
Latter-day Saints).

3. Click Continue.

4. Enter your user name.

5. Type the letters displayed in the picture. Type them as lowercase letters with no
spaces.

6. Click Reset my Password.

7. Enter a new password.

The password must have at least eight characters with at least one letter and one
number.

8. Enter your password again.

9. Click Update.
A message indicates that your password has been changed.

10. Click Close This Browser.

Setting Preferences

Projects are available in different languages and levels of difficulty. To help you choose
batches from projects that you are comfortable indexing, you can set preferences for the
types of projects you would like to work on.

1. On the FamilySearch indexing start page, under the My Batches section, click
Download Batch.

2. Click Edit Preferences.

Note: You can also click the Tools menu, click Options, and on the Project
Preferences tab, click Edit My Preferences.

3. Type your user name and password, and click Sign in.
The My Preferences screen appears. If not, click My Preferences.

4. Click Edit.
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5. Set your preferences for e-mail messages by checking or unchecking the options.

• General updates may include notices about new records available to index, records
finished and available to search, or other general news.

• Account messages includes milestone notices, such as you've indexed 100 batches.

6. Set your project difficulty preference by clicking one of the options.

The default is “All Levels.”

DescriptionLevel

Projects recommended for new volunteers who are still becoming
familiar with the indexing process and system. Typical character
istics of these projects include:

Beginning

• One type of record in a batch
• Preprinted forms with clean column headings
• Highlights provided
• Low number of fields to index
• Easy to follow

Projects recommended for volunteers who are familiar with the
indexing process and comfortable using various system features.
Typical characteristics of these projects include:

Intermediate

• Multiple forms in a batch
• Preprinted forms, but some images may have nonextractable

data or amendments
• Highlights may or may not be provided, but still easy to follow

Projects recommended for experienced volunteers who are com
fortable with the indexing process, system features, and reading

Advanced

a variety of old handwriting styles. Typical characteristics of these
projects include:

• Multiple types of records in a batch
• Free-form records, including nonvital records, such as tax,

land, probate, and so forth
• Names can span multiple images
• Some images have bad quality (faded, water marks, and so

forth)
• Challenging handwriting or written in an old language
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DescriptionLevel

• Many fields to index

7. Set your project language preference by clicking one or more language options.

The default is “All Languages.”

8. Click Save.
You can now select to view only your preferred projects when you click the
Download Batch button.

Invite a Friend

You can send an e-mail to a friend, inviting him or her to help index records.

FamilySearch is digitizing thousands of records. In order to make these digitized images
more accessible, volunteers index names, dates, and places from the images. Everyone
can then search these records and view the indexed information for free. More records
can be available faster if there are more people helping to index.

1. On the FamilySearch indexing start page, at the top right, click Invite a Friend.
An e-mail page appears.

2. Enter your friend's e-mail address.

You can enter more than one address. Separate each address with a comma or
semi-colon.

3. Click Send.
The e-mail will be sent.

4. On the congratulations message, you can click Return to FamilySearch Indexing
Website or close the browser window.
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Chapter 3

Basic Indexing Guidelines

Basic indexing guidelines are instructions that apply to all projects. You can use these
guidelines to answer questions that you have while indexing.

At times, there will be exceptions to these basic rules that will be noted in the field help
and project instructions. Be sure to review the project instructions before indexing a batch.
You can refer to the field help as you index.

Type What You See

Most of the time, you will enter what you see on the record. If there is an exception, it
will be listed in the field help and project instructions.

Remember, you are making an index to help individuals find their ancestors. The
individual can review the information about his or her ancestor on the record image to
form his or her own interpretations and conclusions about an ancestor. If you have
questions as you index:

• Refer to the field help and project instructions.
• Refer to the basic indexing guidelines.
• Use your best judgment.
• Do not assume information that is not specifically listed.
• Contact your local administrator or FamilySearch Support, if needed.

Type Using Lowercase Letters

Type information using uppercase and lowercase letters. Do not use all capital letters.

Batches entered in all capital letters can be confusing. Make sure the Caps Lock key on
your keyboard is not on. The indexing program automatically capitalizes the first letter
of each word in most fields.

Adding Diacritics or Other Characters

If a name or place is written with letters or characters that are not used in the English
alphabet, use International Letters to add the character. For example, if the name is José,
use International Letters to add the accented e (é).

Each international letter is listed twice: in uppercase (for example, Ü) and in lowercase
(ü). Be sure to select the letter that has the case you need.

1. Put your cursor where you need to add the international letter.

Note: For an arbitrator, make the changes in the Arbitrator column.
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2. On the toolbar in the center of the screen, click the International Letters
button.

Note: If you prefer, you can click Edit on the menu bar, and in the drop-down list,
click International Letters.

The list of international letters appears.

3. Click the letter you need to add.
The letter is inserted.

Clearing a Field or Record

Values that you type can easily be deleted or corrected.

1. To clear a field, right-click the field, and select Clear Field.

Note: You can also click the Edit menu, and click Clear Field. You can also press
the Delete key.

2. To clear a record, right-click the first field, and select Clear Record.

Note: You can also click the Edit menu, and click Clear Record. You can also press
Ctrl+Delete.

Note: When there is only one record per image, you may need to change the Image
Type field instead. If clearing a record does not work, change the Image Type to
“Normal.”

Copying from a Previous Field and Record (Ditto Marks)

When a field has the same information as the same field in the record above, (for example,
an individual has the same birthplace as the individual in the previous record), you can
copy the information. Sometimes ditto marks or similar signs of repetition (such as
“ditto” or “do”) appear in a record. Copy the information that was dittoed; do not enter
the ditto mark.

For example, in this record, you would list Thomas Ashton for the second and third
entries.

You may find the following to indicate repetition or the same information.
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• The word "ditto."
• The letters "do."
• Two periods or small slashes to indicate a ditto mark.
• A straight line. You may find a long straight line used as a ditto mark for children's

surnames in a census record. However, a straight line in a place-name may or may
not be a ditto mark. Look over the image to see how the straight line is used, and
refer to the project and field helps.

• The first letter of a surname with a period, such as Maria R. This is often used in
Mexico censuses for the mother and children's surnames.

• A blank field between entries for a family in a ledger document like a census.
Sometimes the census enumerator did not repeat the surname or the birthplace for
each family member. You can interpret the blank field as a ditto only when the
document image clearly groups families together, like in a census.

1. To copy from the same field in the previous record, click in the field where you want
to copy the information, and press Ctrl+D or F5.

Note: You can also click the Edit menu, and click Ditto Field.

2. To copy the information into the same field in several records, click in the field
directly below the field that contains the information you want, then hold down the
Shift key while you click in the last field, and press Ctrl+D.

3. To copy the information into all the fields below, right-click in the field that contains
the information you want, and select Ditto Fields Below.

Note: You can also click the Edit menu, and click Ditto Fields Below.

If a field is set to automatically increment from one record to the next, such as a line
number, when you use Ditto Fields Below, the values will automatically increment.
In a multi-image batch, Ditto Fields Below will not copy information from another
image.
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4. To copy an entire record, click in the first empty field in the new record, and press
Ctrl+Shift+D.

Note: You can also click the Edit menu, and click Ditto Record.

Correcting Information That Was Recorded Incorrectly

Generally, type what you see, even if it is incorrect. However, there are exceptions.
Exceptions should be noted in the field help.

Occasionally, you may find mistakes made by the clerk or person who created the record.

• On a death certificate, the clerk may have listed the death date as February 30, but
February does not have 30 days.

• A place-name may be obviously misspelled.
• The sex does not seem to match the given name and relationship.

Check the field help to see what guidelines, if any, are given for making corrections.
Often, you can fix misspelled place-names.

For projects that give both a given name and relationship, and when the sex listed does
not match the other two indications, list the correct sex based on the other information.
For example, if the given name is Rebecca, and the relationship is Wife, but the sex is
M (for Male), type an F (for Female) in the Sex field.

Rules vary from project to project, so check the field and project helps since an exception
for one project may not apply to another. Remember that the index will point to the
digital image of the document. An individual will be able to see the information on the
original document and determine what corrections to make for the information listed.

Entering Corrected or Crossed-Out Information

On some records, a clerk may have corrected, crossed out, or replaced information.

• If information is crossed out and the clerk wrote replacement information, type the
new replaced information.

• If information is crossed out, not replaced, but you can read the original information
that was crossed out, type the crossed-out information.

• If information is crossed out, not replaced, and the original information cannot be
read, mark the field as unreadable by pressing Ctrl+U.

For example, if the person’s name is listed as “Sophina Klabber,” but the name “Klabber”
was crossed out and replaced with “Klapper,” you would type the following:

Given Name: Sophina
Surname:  Klapper

FamilySearch Indexing (May 2014)54

Basic Indexing Guidelines



Indexing Unreadable Fields and Records

If needed, you can mark a portion of a word, all of a field, or all of a record as unreadable.

1. Type all of the numbers and letters that you can read with a reasonable effort.

2. Indicate which information is unreadable.

• If you cannot read one number or letter, use a question mark (?) to replace the
number or letter you cannot read.

Example: H?ndley

• If there are multiple numbers or letters you cannot read, use an asterisk (*) to
replace the numbers or letters you cannot read.

Example: Di*son

• If you cannot read any of the numbers or letters for a single field, click in the field,

and click the Mark the field unreadable  button.

Note: You can also click in the field, and press Ctrl+U to mark a field as
unreadable. You can also right-click a field and select Mark Field Unreadable.

• If you cannot read any of the numbers or letters for a record, including the name,
date, and any of the other required genealogical information, click in a field for

the record, and click the Mark the record unreadable  button.

Note: You can also click in a field, and press Ctrl+Shift+U to mark an entire
record as unreadable. You can also right-click in a field, and select Mark Record
Unreadable.

• If several records are unreadable, do the following.

1. Click on the first record that is unreadable.
2. While holding down the Shift key, scroll down, and click the last record that

is unreadable. All or part of the column will be highlighted.

3. Click the Mark the record unreadable  button.

If you mark a field or record as unreadable, the system will place the term <Unreadable>
in the field or in the entire record.

Interpreting Difficult Handwriting

Before you begin indexing a project, try to become familiar with the handwriting style
used by the clerk. This will help you to more correctly interpret names, dates, and places.

To interpret handwriting that is difficult to read, do the following:

• Compare how similar letters and numbers were written. If one or two letters are
difficult to read, look for the same letters in familiar words that can be read.

• Compare the principal’s name to the names of the father, mother, spouse, or other
names in the record.

• If an index exists for the record, check to see if it will help clarify the entry. Or compare
the name to supplementary documentation with the record, such as a certificate of
correction.
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• Use the lookup list to see if a similar name is listed. Lookup lists may be helpful in
clarifying names and places. It is important to use the lists to help read the entry, but
the list should not replace what is actually on the record.

• If you still cannot read the handwriting, type as many letters as possible for each
name. Use a question mark (?) to replace one missing letter and an asterisk (*) for
several missing letters.

Marking Blank Fields and Records

If needed, you can mark a required field or a record as blank.

Required fields list <Required> in the field. If a required field is blank, you must mark it
as blank. If a nonrequired field is blank, tab over it to leave it empty, and move on. You
do not need to mark it as blank.

Note: The term “unknown” is usually considered a blank field.

Sometimes a small portion of a page will be torn or missing. In this case, index all the
information you can see, and mark missing required fields and records as blank.

Sometimes, an image may have fewer records than normal, with several blank lines.
Follow these guidelines:

• If the blank line is in a project with typed or handwritten line numbers, mark the
entire record blank. Do not index the blank line number. If there are multiple blank
lines, mark all those records as blank.

• If the blank line is in a project without line numbers, skip the blank line and index
any records below it. When you are finished indexing that image, delete any extra
records in the data entry area. If there are extra records in the data entry area that
you cannot delete, then mark those records as blank.

• If a required field is blank, click in the field, and click the Mark the field blank

 button.

Note: You can also click in the field, and press Ctrl+B to mark the field as blank.
You can also right-click a field, and select Mark Field Blank.

• If an entire record is blank, click in a field for the record, and click the Mark the

record blank  button.

Note: You can also click in a field and press Ctrl+Shift+B to mark the record as
blank. You can also right-click a field and select Mark Record Blank.
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• To mark multiple records as blank, do the following.

a. Click on the first record that is blank.
b. While holding down the Shift key, scroll down, and click the last record that is

blank.
All or part of the column will be highlighted.

c. Click the Mark the record blank  button.

The system will place the term <Blank> in the field or in the entire record. If you are
marking the last record in the batch as blank, scroll to the last field of that record, and
press Enter to start the quality check.

What Are Red Wavy Lines and Colored Backgrounds?

As you enter data, any information that does not match the lookup list appears with a
red wavy line or colored background. This does not mean your entry is wrong. The mark
indicates that what you typed is not what the program expected.

The lookup lists are limited and may not include every variation in spelling, particularly
for names. The lists are intended as a guide to help you decipher information that is
difficult to read.

During the quality check, you can recheck what you entered to be certain it is what you
meant to enter. The marks are removed after the quality check.

Using a Lookup List

A lookup list is a collection of common names, places, races, or other types of information
that can help you decipher a field. The lookup lists automatically download with your
batch and are available as you index. If you have trouble reading information in a field,
you can check to see if the name or place appears in the lookup list. However, the lookup
lists are limited and don't include every spelling variation, especially for names.

If a field has a lookup list, when you click the down arrow at the end of the field,
Lookup will appear at the end of the drop-down list.
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1. To use a lookup list, click in the field you want to index.

2. Click the down arrow at the end of the field, and click Lookup.

Note: You can also click in the field, and press Ctrl+F to go to the lookup list. For
a Macintosh computer, press Control+Option. Or, from the Edit menu, click
Lookup.

3. In the appropriate fields, type the letters you can decipher.

• If you can read the first letters of the word, type the letters in the Starts with
field.

• If you can read some of the letters in the middle part of the word, type the letters
in the Contains field.

• If you can read the end of the word, type the letters in the Ends with field.

Note: You can put letters into more than one field.

As you type, a list of the words that match your information is displayed.

4. Select the name or information that matches the information in the document.

• If you find a match, click the match, and click Accept Selected.
• If you do not find a match, click Cancel, and type what you see in the record.

Using Auto-Completion

As you index a batch, you may often type the same information into a field (for example,
the same family surname or the same birthplace). If you typed the name or place in
another record within the batch, the auto-completion feature will fill in the field as you
type. The auto-completion feature can increase accuracy and productivity.

For example, if you are indexing a family, after you type the surname for the first family
member, as you type the first letter of the surname for the next family member, the
auto-completion feature will put the surname into the field. If that is the surname you
want, you can stop typing and press Enter. You save time, and the family surname is
spelled consistently.

By default, the system provides the auto-completion feature unless you turn it off. The
auto-completion feature only works within a batch. It does not work between batches.

To use the auto-completion feature, do the following:

1. Begin to type information in a field.
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2. If the auto-completion feature fills in the field with the information you want, stop
typing, and press Enter.

Caution: Do not press Enter until the correct information appears. The
auto-completion feature supplies the last matching information you typed. For
example, if you want to type “Illinois” but you last typed “Iowa,” when you type “I,”
the auto-completion feature lists “Iowa” in the field. When you type the second letter
“l,” Iowa is removed, and Illinois appears. As soon as you see the information you
want, you can stop typing and press Enter. Watch out for names that may or may
not have a middle initial, such as “Sarah” and “Sarah H.”

Turning Off Auto-Completion

When you begin indexing, the auto-completion feature is automatically turned on. If
you do not want to use the auto-completion feature, you can turn it off.

1. On the menu bar, click Tools.

2. Click Options.

3. Click the Display tab.

4. Click Enable field auto-completion.
This will remove the check mark.

5. Click OK.

Managing the Field History

A list of everything you type in a field is kept as long as you are working in the same
batch (for example, a list of all the fathers’ birthplaces). This is called a field history. The
field history is used by the auto-completion feature. On rare occasions, you may decide
to delete information (such as a misspelled location) from a field history.

1. Click the down arrow at the end of the field.

2. In the drop-down list, click Manage History.

3. Click the information (name, place, relationship, and so on) that you want to delete
from the field history.

4. Click Delete.

Before you close the Manage History window, if you decide you do not want to delete
the information, click Undo.
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Using Standard Editing Features

You can use the standard editing features of cut, copy, paste, undo, and redo.

1. To cut or remove a value in a field, click and highlight the text, and press Ctrl+X,

or click the Cut  button.

2. To copy a value, click and highlight the text, and press Ctrl+C, or click the Copy

button.

3. To paste a value, click in the field, and press Ctrl+V , or click the Paste button.

4. To undo an action, press Ctrl+Z, or click the Undo button.

5. To redo an action, press Ctrl+Y, or click the Redo button.

Short-Cut Keys and Buttons

You can use these keyboard short-cuts instead of menu items in FamilySearch indexing.
Small action buttons are also included in the list.

Keyboard Short-Cuts and Buttons

ButtonShort-CutDescription

Ctrl+TAccept field value (for quality checker)

Ctrl+JAccept Key A (used by arbitrators)

Ctrl+KAccept Key B (used by arbitrators)

Add line (used by arbitrators when matching
records)

Ctrl+Alt+ ArrowAdjust Highlights

Ctrl+Shift+InsertAppend Record (add at the end)

DeleteClear field

Ctrl+DeleteClear Record

Ctrl+F4Close Batch

Ctrl+CCopy

Ctrl+XCut

Delete line (used by arbitrators when match
ing records)

Delete Record

Ctrl+D or F5Ditto (copy previous) field

Ctrl+Shift+DDitto (copy previous) record
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ButtonShort-CutDescription

F2Edit field

Ctrl+Alt+HHandwriting Help

F1Help

Ctrl+InsertInsert record before

Ctrl+LInternational Letters

Ctrl+IInvert (image)

Ctrl+FLookup (list)

Ctrl+BMark field blank

Ctrl+UMark field unreadable

Ctrl+Shift+BMark record blank

Ctrl+Shift+UMark record unreadable

Move record (used by arbitrators when
matching records)

Tab or EnterMove to the next field

F10Move to the next record

Shift+Tab or
Shift+Enter

Move to the previous field

Ctrl+VPaste

F4Quick Download (downloads a batch from
the highest priority project)

Ctrl+YRedo

Resize image

Return batch to be reindexed (used by arbitra
tors)

Ctrl+F4Return to the start page (My Work)

Rotate image

Ctrl+SSave

Show previous or next image

Submit
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ButtonShort-CutDescription

Ctrl+ZUndo

View Highlights

Ctrl+Alt+QView Quick Start demonstration

Indexing Names

There are several guidelines on indexing names. As you enter names, type actual names
in the Given Name and Surname fields.

At times, there will be exceptions to these basic rules that will be noted in the field help
and project instructions. Be sure to review the project instructions before indexing a
batch. You can refer to the field help as you index.

Index the Most Complete Name

Sometimes a name is recorded more than once. If so, type only the most complete version
of the name.

For example, on a marriage certificate, the name of the groom may appear in two or
three different places. In one place, the name may be written as C. H. Johnson. In another,
it may be Chas. H. Johnson. And in yet a third place, the name may be written as Charles
Henry Johnson. Type the most complete version of the name. This will increase the
chances of an individual finding the name of an ancestor in the index.

Abbreviations

Sometimes names are abbreviated, or a portion of the letters are written raised above
the rest of the name (for example Wm. or Thos). Type the abbreviation as it is recorded
on the image, such as Wm or Thos. Do not superscript the “s” in Thos. Do not type a
period at the end of the abbreviated name. Do not guess what the abbreviation stands
for unless directed to do so in the project or field instructions.

For example, if an individual’s name is listed as “Ma. Teresa Gomez Reyes,” you would
type the following:

Given Name: Ma Teresa

Surname: Gomez Reyes

Maiden Names

Maiden names (a woman's surname before she is married) are considered surnames.

Follow these guidelines for maiden names.

• If both the maiden name and married name were recorded for a woman, including
other surnames from previous marriages, index all the surnames in the Surname field.
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• Maiden names should be typed in the Surname field before the married surname. For
example, if a woman’s name is listed as “Lura (Beck) Brannon,” and her father’s name
is listed as “George Beck,” type the following:

Given Name: Lura

Surname: Beck Brannon

• If a Surname field or Maiden Name field calls for a maiden name and only the married
name was recorded, index the married name in the Surname field or Maiden Name
field.

• If you cannot determine if the name is a given name or a surname, type the name in
the Given Name field.

Name Titles and Terms

Do not type a title or term in the Given Name or Surname field. Type the title or term
in the Titles and Terms field for that record.

Examples of titles and terms that are not written in the Given Name or
Surname field

Titles: Jr., Sr., Mrs., Señor, Señora, Don, Doña, Captain, Dr., and so on.

Terms: Not named, stillborn, twin, infant, and so on.

Note: In most projects, “unknown” is marked as a blank field.

• In general, do not index occupations in the Titles and Terms field unless they are
used as a preface to the name, such as “Dr. Brown.”

• If no Titles and Terms field is included in your batch, do not include them.
• Type what you see, including hyphens and apostrophes, but not punctuation (such

as the period).
• If Mrs. is used before a male name, such as “Mrs. Jason Jones,” index it as:

Titles and Terms: Mrs

Given Name: Jason

Surname: Jones

• If a child is designated as “Stillborn,” type Stillborn in the Titles and Terms field.
• If there are two titles or terms, such as “Mr. Jr. Jones,” enter both titles and terms

with no punctuation and a space between, such as:

Titles and Terms: Mr Jr

Surname: Jones

Name Variations

A name variation or alias is an assumed or additional name. AKA means “also known
as” and indicates another name the person was known by.

Variations

If you see variations of a name listed in the record, type both versions separating them
with the word “or.” For example,

• Frederico or Francis
• Elisabeth or Elizabeth
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• Millett or Millet

Aliases or AKA

To index a name that has one or more aliases or uses an AKA, type the word or between
each name.

For example, if an individual’s name is listed as “Joseph Broski AKA Joseph Browzowski
AKA Jozef Brzozowski,” you would type the following:

Given Name: Joseph or Jozef

Surname: Broski or Browzowski or Brzozowski

Names with Prefixes

Sometimes it is difficult to tell from the way surnames with prefixes are written on the
original record whether there is a space between the prefix and the surname. Either way
is correct. The system overlooks spaces. So type what you see.

Example

For the above record, you can type:

Surname: McFeaters

No Middle Name

If the record indicates that the individual had no middle name or initial, type the given
name and the surname in the appropriate fields. Do not include terms that are used in
the record to indicate that no middle initial was recorded.

Examples of terms or symbols that indicate the individual had no middle
name

(none)
(n)
NMI (no middle initial)
NMN (no middle name)
- - - -
A blank space in the middle initial field

No Surname

Sometimes a surname is not given immediately following a given name, although it
may be given with another family member's name.

Depending on the situation, you may or may not assume a missing surname.

• If you are indexing a record that lists a family together in a group, such as a census,
and the wife and children do not have the surname listed, you may assume the
surname is the same as the father and list the father's surname as the wife's surname
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and child's surname. There may or may not be ditto marks under the surname of the
Head of Household.

• If the record lists a husband and wife as "John and Mary Smith," you may assume
that the husband's surname is Smith and list both the husband's and wife's surname
as "Smith."

• If the record lists a husband and wife as "John Smith and Mary," do not assume Mary's
surname. In this case, mark the wife's surname as blank.

• If the record lists a child as "Sarah, daughter of John Smith," do not assume Sarah's
surname. In this case, mark the child's surname as blank.

Note: However, if the record lists a child as "Sarah, daughter of John Smith" and there
is no place to index the parent's name, you may list the parent's surname as the child's
surname.

• If a christening record form indicates that the surname listed is for both parents, then
index that surname for both parents.

After indexing is completed, projects go through a process where the information is
prepared to make it searchable. As part of this process, in countries and time frames
where naming conventions make sense, the surname of one member of a family will be
included as the surname for another member of the family.

Punctuation

Some punctuation is indexed, and some is not. If punctuation, such as a hyphen (-) or
an apostrophe (’), is normally part of a name, type it. If not, do not include it. Do not
type a period after an initial or abbreviated name. Do not type commas, parentheses, or
semicolons after initials or abbreviations.

For example, if an individual’s name is listed as “William H. O'Rourke,” you would type
the following:

Given Name: William H

Surname: O’Rourke

(Do not type a period after the abbreviation for the middle name, but type the apostrophe
(’) as part of the surname.)

Do include the following.

Hyphens when they are used in a name, such as “Wilson-Gaston.”
Apostrophes when they are used in a name, such as “O'Farrell.”
Equal signs when they are used in a name, such as “wey=ah=doh.”

Quotes and Parentheses

If there are quotes or parentheses around a name, type only the name. Do not include
the quote marks or the parentheses. When it appears that the clerk used the quotes or
the parentheses to indicate an alias or other name, use the word “or” between the names.

For example, if an individual's name was listed as “John 'Buck' Harrison,” you would
type the following:

Given Name: John or Buck

Surname: Harrison
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Women with Husband's Name

Sometimes you may find a woman listed with her husband's name, such as “Mrs. John
White.”

If you cannot find her given name listed anywhere else, index the name as:

Given Name: John
Surname: White
Titles and Terms: Mrs

Names of Catholic Nuns and Fathers

Index only the name in the Given Name and Surname field. The terms “Sister” and
“Father” should be listed in the Titles and Terms field.

Often the names of nuns are recorded with the name given by the Catholic order first,
and then the legal civil name. Index the names given by the Catholic order in the Given
Name field, then “or,” and then the legal given name. If you are not sure which is the
given name and which is the surname, type all of the name in the Given Name field.
For example, a death certificate that listed “Sister Mary Gosberta (Clara Crefeld)” would
be indexed as:

Given Name: Mary Gosberta or Clara
Surname: Crefeld
Titles and Terms: Sister

Catholic priests may be listed by either their given name or surname. If you are not sure
which is the given name and which is the surname, type all of the name in the Given
Name field. For example, a census record that listed “Father Martin” would be indexed
as:

Given Name: Martin
Surname: <blank>
Titles and Terms: Father

Names from Other Cultures

You may find records with only one name listed or records where it is difficult to
determine which name is the surname and which is the given name. This is especially
true for names from other cultures that you may not be familiar with, such as Chinese,
Japanese, Indian, and Eskimo names in an English record.

If you are not sure whether a name is a given name or a surname, type the whole name
into the Given Name field. List the name in the same order as it was written on the page.
If the name has hyphens, equal signs, or other marks, include the marks with the name.

Maiden names are considered surnames and should be typed before the married name
in the Surname field.
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Two Names on the Same Line

If you see the names of two or more individuals appearing on the same line, index each
name separately.

Following are some examples:

• Sometimes on a census you may see more than one name of an individual on a line,
such as for twins or other multiple births. In this case, index each name separately.
Insert a new record in the data entry area for the second name. Keep the names in
the same order as they appear on the document, and use the same line number for
both names. For example, if the census record had 50 records, but one line listed two
names, the record numbers would increase to 51 when you inserted a record for the
second name. But the line number at the end would show 50, because you would list
the same line number for both names on that line.

• If a document says “James Brown and Mary,” you would index two records, one for
James Brown and one for Mary.

• If the document says “Mr and Mrs Smith,” you would index two records, one for Mr
Smith and one for Mrs Smith.

However, if another family member is referred to, but the name is not given, do not
index that individual. For example, if the document says “James Brown and mother,”
or “James Brown and brothers,” or “James Brown and 3 children,” you would only index
James Brown. Do not assume that the mother, brothers, or children share the same last
name. Do not create any additional records for the mother, brothers, or children.

In the example below, the document says, “Mr. Pratt Wife & 5 children." Do not assume
that the wife and children share the same last name as Mr. Pratt. Only one record should
be indexed, the one for Mr. Pratt.

Two Spouses or Parents

When multiple spouses or parents are listed, index only the current spouse or parents.

Follow these guidelines for multiple spouses or parents listed on a record:

• If there are multiple spouses listed, index only the present or current spouse. Do not
add a record to index a previous spouse.

• If there are multiple parents listed, such as a set of birth parents and a set of adoptive
parents, index only the current set of adoptive parents. Do not add a record to index
both sets of parents.
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Indexing Dates

There are a few guidelines on indexing dates.

At times, there will be exceptions to these basic rules that will be noted in the field help
and project instructions. Be sure to review the project instructions before indexing a
batch. You can refer to the field help as you index.

Dates are usually about an event, such as birth, marriage, or death. When indexing a
date, there will usually be three fields: one for the day, the month, and the year. The
Day and Year fields only recognize numbers. The Month field will usually have a list
you can pick from.

Missing Dates

If a date is missing, try to determine at least the year. Records are often listed
chronologically by year, and you may be able to determine the year by looking at the
previous or next image for this record.

Dates Listed as Numbers

If the date is listed as numbers, such as 3-4-1828, and you cannot tell which is the day
and which is the month, see if you can determine the correct date.

• Check other dates in this record to see if you can determine whether it lists the day
or month first. See if there are other dates with a number over 12, indicating that it
is a day instead of a month.

• Consider the country that this document originated in, and follow the format for
that country.

Dual Dates

Over time, countries have switched calendars. You may find two dates listed during the
time when the calendar was changing.

For example, while the European countries were switching from the Julian calendar to
the Gregorian calendar, from 1582 to 1752, dates from January through March may
have been recorded with a dual year, and sometimes a dual day or month.

See the project instructions and field helps on how to handle dual dates. If there are no
guidelines, list both dates, separating them with the word “or,” such as 1843 or 1848.

Date Ranges

If a date is given as a range, index the first date in the range.

For example, if the date was recorded as “between February 2 and March 9, 1937,” index
the first date “2 Feb 1937.”
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Recent Dates

Sometimes, you may find a date that is more recent, or outside of the project's normal
date range.

For example, you may find a birth record in 1989 included with some older records. Go
ahead and index the more recent record. FamilySearch always checks the dates and only
displays records that meet the rights of privacy rules.

Indexing Ages

There are a few guidelines on indexing ages.

At times, there will be exceptions to these basic rules that will be noted in the field help
and project instructions. Be sure to review the project instructions before indexing a
batch. You can refer to the field help as you index.

Some projects have a single age field. Other projects have multiple age fields, where the
age is listed in days, months, and years separately.

Single Age Field for Day, Month, and Year

The field instructions should indicate how to index the age.

Usually, you will type the age followed by a letter: “y” for years, “m” for months, and
“d” for days. For example, 4 years, 3 months, and 5 days would be indexed as 4y3m5d.
If a record lists weeks, you can include “w” for weeks.

• If a fraction is listed for the age, such as “3/12,” change the fraction to months, such
as 3m.

• If a child was listed as stillborn, index the age as zero: 0
• If a “0” or a blank is listed in any of the age fields, list the age with what is given. Do

not include the zero “0.” For example, if the age is 6 years, 0 months, and 5 days,
index it as 6y5d.

• If the age is blank or the word “infant” or “unknown” is listed, mark the age as blank.
• If the age is listed as “over,” such as a male listed as over 21 or a female listed as over

18, mark the age as blank.
• If you are indexing a non-English batch, use the appropriate abbreviations for year,

month, and day for that language. See the field help for more information.

Separate Age Fields for Day, Month, and Year

Most newer projects have separate fields for days, months, and years when indexing the
age. For some records, you may even see weeks.

• If a fraction is listed for the age, such as “3/12,” change the fraction to months, such
as 3 in the Months field. If it is a strange fraction, such as “1/48,” mark the age as
unreadable.

• Type only numbers. Do not include a “y” for years or “m” for months.
• If a child was listed as stillborn, index the age as zero: 0
• If the age listed is less than the smallest amount asked for in the project, round up.

For example, in a death record if a child only lived for a few hours, index it as 1 day.
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• If a record indicates weeks and there is not a field for weeks, convert the weeks to
days (1 week = 7 days), and enter that number in the Days field.

• If the age is blank or the word “infant” or “unknown” is listed, mark the age as blank.
• If the age is listed as “over,” such as a male listed as over 21 or a female listed as over

18, mark the age as blank.

Year-Only Age Field

Some newer projects have a year-only field for the age.

• List ages as full years only.
• Type only numbers. Do not include a “y” after the number.
• Do not include words such as “about,” “abt,” or “full age.”
• If the age includes days, weeks, or months, or fractions for the age, such as “3/12,”

round down to the nearest full year. For example, if a child is listed as “5 years and
8/12 months,” list the age as “5.”

• If a child is less than 1 year old, or listed as stillborn, round down to “0” (zero).
• If the record lists the “age at the next birthday,” list the age that is given.
• If the age is blank or the word “infant” or “unknown” is listed, mark the age as blank.
• If the age is listed as “over,” such as a male listed as over 21 or a female listed as over

18, mark the age as blank.

Indexing Places

There are a few guidelines on indexing places.

At times, there will be exceptions to these basic rules that will be noted in the field help
and project instructions. Be sure to review the project instructions before indexing a
batch. You can refer to the field help as you index.

Place-Names

Each project will provide specific instructions on how to type place-names. Generally,
type only the name of the place (for example, type London, not “city of London”).

• Do not include terms such as “county of,” “county,” “resided in,” “rural,” “of,” and
so on.

• Do not type periods, commas, parentheses, or semicolons between levels of localities
for any of the fields.

• For most projects, you can expand abbreviations and correct misspellings of
place-names. Use the Lookup list to help find the correct spelling. If you cannot
determine the correct spelling, type what is recorded on the document.

• If the project instructions or field help do not say to expand an abbreviation, and the
place is listed with the first letter of each word, such as “U.S.” for United States or "N
Y" for New York, index the letters without a space, such as US or NY.

• Do not include information that does not appear on the record. Some fields may ask
for a specific type of place, such as the state, and exclude others. For example, if a
county was recorded and you believe you know what state that county is in, do not
index the state unless it is actually written on the record.

• A province may be indexed in the State field, and a state or province may be indexed
in a Territory field in any project.
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• If a place is not part of the project, index the place listed. For example, if you are
indexing birth records from Manchester parish, but births from a neighboring parish
are included, list the correct parish that appears in the record.

• If you cannot determine the level of the locality, such as whether the place listed is
a city, county, or state, put the place in the smallest geographical division.

Indexing Unusual Images

Occasionally, you may find an image that you are not sure how to index.

At times, there will be exceptions to these basic rules that will be noted in the project
instructions. Be sure to review the project instructions before indexing a batch.

Blank Images

A printed form with no vital information recorded on it is considered blank. The page
may have some header information, but there are no names, dates, or places written.

Before you indicate that an image is blank, first reduce the image to 10% to make sure
you are viewing everything on your screen. Some images contain two pages, and some
images may have a large blank area before the actual page. Then enlarge the image, and
move around the whole image to make sure there is no vital information available.

If the image is blank, do the following:

1. In the Image Type field, select Blank Image.
2. On the warning message, click Yes. The program will mark all the fields with

“<blank>.”
3. Finish indexing other images, if there are any.
4. Submit the batch.

Duplicate Images

A duplicate image is a document page that is exactly the same as a previous or next
document page.

Look over both images carefully to ensure that the images are exactly the same. Compare
header information, names on the images, and so forth. Make sure there is not an overlay,
or smaller piece of paper laying on top of a document page.

Check the project instructions to see if they mention what to do about duplicate images.

If the image is a duplicate, do the following:

1. Index the image that is easiest to read.
2. For the other image, in the Image Type field, select Duplicate Image.
3. On the warning message, click Yes.
4. Finish indexing other images in the batch.
5. Submit the batch.

If the duplicate image is a previous or next page image that is not part of your batch, do
the following:

1. Index the image from your batch.
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2. If you are missing information that would have appeared on the previous image,
mark that field as blank. For example, if you are indexing a census, and you were
looking for a missing surname on the previous image, mark the Surname field as
blank.

3. Submit the batch.

Unreadable Images

An unreadable image is an image that is either too light, too dark, or too damaged for
you to read and index any of the required information.

If an image is too light or too dark, first try adjusting the image brightness and contrast
to see if you can make it more readable. Try inverting the image to see if it makes it
easier to read the text. If you still cannot read the document, mark the document as
unreadable.

To mark an image as unreadable, do the following:

1. In the Image Type field, select Unreadable Image.
2. On the warning message, click Yes.
3. At the top, click the File menu, and then click Return Batch.
4. On the Return Batch screen, click Review Image Quality. An administrator will

review this batch to see what can be done to make it more readable.

Images with Overlays

An overlay is one document page that lays on top of another document page. Usually
there will be two images, one with the overlay showing and one without.

To determine how to index an overlay page, read the project instructions. How to handle
overlays may vary, depending on the project. If the project instructions do not mention
how to handle overlays, then do the following.

1. Index what you can see.

• Determine if there is information on the overlay that matches the fields you are
indexing. If so, then index the information on the overlay.

• If the information behind the overlay is not included on another image and is
unique, index as much as you can see on the page under the overlay.

• If the information behind the overlay is duplicated elsewhere, then ignore it.
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2. If neither the overlay nor the information behind the overlay needs to be indexed,
then do the following:

• In the Image Type field, select No Extractable Data Image.
• On the warning message, click Yes.

3. Finish indexing other images in this batch, if there are any.
4. Submit the batch.

Part of the Image Is Missing

Part of an image is missing if part of a page is torn off or if there was a problem in
digitizing the image and you cannot view part of it.

If some of the page is missing because another page is covering it, see “Images with
Overlays”.

If part of the page was torn off, there is nothing we can do about the missing part. In
this case, index what you can see, and mark the missing required fields blank.

If part of the page is cut off because of a filming or digitizing problem, then do the
following.

1. At the top, click the File menu, and then click Return Batch.
2. On the Return Batch screen, click Review Image Quality. An administrator will

review this batch.

Images with Indexes

An image may contain other information, such as an index,

Determine if there is vital information that needs to be indexed.

• If an index includes only names and page numbers, it is usually not indexed, since
that information is included elsewhere in a project.

• If an index includes names, dates, and places, it is usually indexed. For marriage
indexes, it should include the name of the groom, the bride, and the event date to
be indexed.

• If an image has a list of names, and you aren't sure whether or not those names would
be included elsewhere, it should be indexed. Any missing required fields should be
marked blank.

Check the project instructions to see if there are any guidelines on how to handle images
with other information. The instructions may list specific types of images and whether
or not you should index those images.

If you determine that this is an image that does not contain information to be indexed,
then do the following:

1. In the Image Type field, select No Extractable Data Image.
2. On the warning message, click Yes.
3. Finish indexing other images, if any.
4. Submit the batch.
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Images with Other Information

An image may contain other information, such as a table of contents, or a title board
or marker used by a camera operator.

Determine if there is vital information that needs to be indexed.

If an image has a list of names, and you aren't sure whether or not those names would
be included elsewhere, it should be indexed. Any missing required fields should be
marked blank.

Check the project instructions to see if there are any guidelines on how to handle images
with other information. The instructions may list specific types of images and whether
or not you should index those images.

If you determine that this is an image that does not contain information to be indexed,
then do the following:

1. In the Image Type field, select No Extractable Data Image.
2. On the warning message, click Yes.
3. Finish indexing other images, if any.
4. Submit the batch.
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Chapter 4

Adjustments to the Indexing
Screen

There are several adjustments you can make to both the image area and the data entry
area.

Adjust Image Brightness and Contrast

If the image looks too light or too dark, you can adjust the brightness and contrast on
the image.

1. Click the Brightness or Contrast  button.

Note: You can also click the View menu, and click Brightness/Contrast.

2. To change the brightness, click and drag the slider.

• To darken the image, move the slider to the left of zero.
• To lighten the image, move the slider to the right of zero.

The changes are shown on the image.

3. To change the contrast, click and drag the slider.
The changes are shown on the image.

4. When you are finished, click OK.

Adjust the Image Size

The image opens at the default size of 50 percent. You can adjust the size of the image.
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To quickly adjust the size, do one of the following.

• To increase the image size, click the Zoom in  button.

• To decrease the image size, click the Zoom out  button.
• Click the Zoom drop-down list, and select a percentage size.

Note: You can also type in a size.

Adjust Image Size Using the Zoom Menu

You can select a custom size using the zoom menu option.

1. Click the View menu, and click Zoom.

2. Click a percentage size, and click Apply.
The image size will change. You can decide to keep this image size or select another
size.

3. To select a custom size, click Custom, and type a percentage size. Then click Apply.

4. When you are finished, click Close.

Adjust Text Size

On the indexing screen, you can change the size of the text in the data entry area and
field help. This also changes the text size of the messages on the indexing start page.

1. Click the Tools menu, and click Options.
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2. Click the Text Size tab.

3. Click a size from smallest to largest.

4. Click OK.

Note: If you are on the indexing screen, you need to close it and reopen it to see the
changed text size. At the top left, click Close and Return to Start Page. Then in
the My Batches section, double-click the batch to reopen it.

When you change the text size, it affects the following text:

• The column titles.
• The record numbers along the left side.
• Fields where you type information.
• Field help, project information, and quality check.
• On the Indexing start page, the headings for each area and the message text.

Change the Display Options

You can change how several options display.

1. Click the Tools menu, and then click Options.

2. Click the Display tab.
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3. Indicate your changes.

• Auto-completion automatically fills in a field as you type with similar information
you have typed before. A check mark in the box turns auto-completion on. A blank
box turns auto-completion off.

• In sound alerts, a beep will sound if incorrect characters are entered into a field,
such as letters instead of numbers in a Date Year field. A check mark in the box
turns sound alerts on. A blank box turns sound alerts off.

• The tip of the day will appear each time the program is opened. A check mark in
the box turns Show Tip of the Day on. A blank box turns this feature off.

• You can choose whether to have solid highlights or an outline. A check mark in
the box indicates a solid highlight. A blank box indicates an outline.

• You can select the highlight color and transparency.
• When you enter information the program did not expect, a colored background

or red wavy line appears in the field. This mark remains until after the quality
check. A check mark in the Display background color of fields marked for
review instead of red wavy underline box displays a colored background in
a field marked for review. A blank box displays a red wavy underline in a field
marked for review.

• You can change the color and transparency of the colored background in a field
marked for review.

4. Click OK.

Change the Language

You can change the language for program text, field names, and field help.

1. Click the Tools menu, and click Options.
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2. Click the Language tab.

3. To change the program text, click the Application language drop-down list, and
select a language.

4. To change the field names, click the Language for Field Names drop-down list,
and select English or Same as Document.

5. To change the field help, click the Language for Field Help drop-down list, and
select English or Same as Document.

6. Click OK.

• If you are changing the application language, on the message that the application
must be restarted, click OK. The indexing program will close. When you restart
FamilySearch indexing, the indexing program will appear in the language you
selected.

• If you are changing the field names or field help, at the top left, click Close and
Return to Start Page. Then in the My Work section, double-click the batch to
reopen it. The field names or field help will appear in the language you selected.

Change the Red Wavy Line or Colored Background

When a value you enter does not match a value in the lookup list, a red wavy line or
colored background appears. This does not mean your entry is wrong. The mark indicates
that what you typed is not what the program expected. During the quality check, you
can recheck what you entered to be certain it is what you meant to enter. The marks are
removed after the quality check. You can adjust how these fields are marked for review.

1. Click the Tools menu, and click Options.

2. Click the Display tab.
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3. To display only the colored background and not the red wavy line, click Display
background color in fields marked for review instead of wavy underline.

4. To adjust the colored background, click the Mark Color drop-down list, and select
a color.

5. To adjust the transparency of the colored background, in Mark Color Transparency,
click and drag the slider.

• To make the background less visible, move the slider to the left.
• To make the background more visible, move the slider to the right.

6. If you want to display the red wavy line instead of a colored background, click Display
background color in fields marked for review instead of wavy underline
to uncheck it.

7. Click OK.

Invert the Image

If the information on the image is difficult to read, you can invert the image to white
writing on a black background. This may make the writing easier to read.

1. To invert an image, click the Invert  button.

Note: You can also click the View menu, and click Invert.

2. To change an image back, click the Invert button again.
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Mirror the Image

If the writing on the image appears to be backward, you can mirror the image to flip the
writing around.

1. To mirror an image, click the View menu, and click Mirror.

2. To change the image back, click the View menu, and click Mirror again.

Moving Around the Image

If needed, you can move around the image to view the information you need.

Some images may have more than one page of a document. Check the whole image to
make sure you have indexed all the information. A second page could be to the right or
below the page that is first visible. To check for a second page, you can either move
around the image, or change the image size so it is very small, such as 25% or less.

Use one of the following methods to quickly move around the image.

• Place the mouse over the image, and click and drag the image.
• Use the scroll bars on the right and in the middle to scroll up, down, left, or right.
• Click the Image Navigation tab, and click and drag the gray highlight to the

image portion you want to view.

Note: This will move only the image in the batch, not a previous or next image.

Click the Field Help tab to close the Image Navigation tab. Image Navigation must
be closed for data entry to work properly.

Organize Fields

The indexing fields are usually set up in order so you can smoothly move through the
document being indexed. However, if needed, you can rearrange the order of the fields
or hide fields that are not needed.

Note: You cannot organize fields in projects with Form Entry view only.

1. Click the View menu, and click Organize Fields.

Note: You can also right-click the column header and select Organize Fields.
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A window showing the fields in vertical order appears.

2. To move a field, in the Selected Fields list, click a field name, and click the up or
down arrow to move the field in the list.

3. To hide a field, in the Selected Fields list, click a field name, and click the right
arrow to move the field to the Hidden Fields list.

Note: Hiding a field does not change whether the field is required or not. If required
fields are hidden, the quality checker will force them to be visible and the required
field will need to be given a value or marked as blank before the batch can be
submitted.

4. To unhide a field, in the Hidden Fields list, click a field name, and click the left
arrow to move the field to the Selected Fields list.

Note: When you move a field from the Hidden Fields list, it is added at the bottom
of the Selected Fields list. If needed, move it up to where it needs to appear in the
list.

5. Click OK.

Sharpen the Image

If the image appears slightly blurry, you can adjust the focus for the image.

1. Click the View menu, and click Sharpen.
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2. Click and drag the slider to select the amount of sharpening.

3. Click OK.

Show Next or Previous Image

The information to be indexed may spread across two document pages or images. You
may need to see an image previous to the one in your batch, or following the one in
your batch, to include all the information for an individual.

For example, if you are indexing a census, the surname may have only been recorded
for the father, with a ditto mark to indicate it is the same for each child. If your page
starts with a child, in order to view the child's surname, you would need to see the
previous image that lists the father.

1. Click the Show Previous or Next Image  button.

Note: You can also click the View menu, and click Show Previous/Next Image.

The previous or next image will appear on a side-by-side screen next to the image
you are viewing.

Figure 8: Show Previous/Next Image

Note: If a previous or next image is not available, you will get a message indicating
that there is no image. This can happen if the batch was from the beginning or end
of a roll of microfilm.

2. Enter the information you need from the image.

Note: Enter only the information you need for the individual on the image in your
batch. Do not index additional records from the previous or next image.

3. When you are finished, click the Show Previous/Next Image  button again to
return to viewing just the image in your batch.

Note: You can also click the Close  button for the next or previous image.
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Rotate the Image

You can rotate an image 90 degrees to the left or right.

To rotate an image 180 degrees, click the Rotate button twice.

1. To rotate the image 90 degrees counterclockwise, click the Rotate Left  button.

Note: You can also click the View menu, and click Rotate Left.

2. To rotate the image 90 degrees clockwise, click the Rotate Right  button.

Note: You can also click the View menu, and click Rotate Right.

Use Highlights

Highlights can make indexing easier by highlighting each field on the image as you
move from field to field entering information.

Highlights provide a colored transparent background slightly larger than the information
on the image you are transcribing. You can adjust the color, transparency, and placement
of the highlight.

Note: Not all projects have highlights available. Some projects use only the ruler. If
highlights are not available, these options will appear inactive.

1. To turn highlights on, click the Highlighter Pen  button at the top of the screen.

Note: Selecting the highlight automatically turns off the ruler. And selecting the
ruler automatically turns off the highlight. Only one option will display at a time.

2. To turn highlights off, click the Highlighter Pen  button again.

Move Highlights

You can quickly move all the highlights left, right, up, or down if needed, to match the
placement of information on the image.

1. On the keyboard, press Ctrl+Alt+ arrow key. Move the highlight left, right, up,
or down, as needed.

Note: You can also click the View menu, point to Move Highlights, and then
click Left, Up, Right, or Down, as desired.

2. To move the highlights using a project option, click the Highlight drop-down list,
and select an option.

Note: Options vary depending on the project. For example, the options below display
for census-type documents.
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• Down One Line: Moves the highlight down one line.
• Up One Line: Moves the highlight up one line.
• Center: Returns the highlight to where you started.

Adjust Highlights

If the highlight's position is off significantly, you will need to adjust the highlights so
they appear over the appropriate information on the image.

1. Click the View menu, and then click Adjust Highlights.

2. Move the mouse over the document image until you see a yellow grid of highlights
with a thin red border. Then do one or more of the following:

Figure 9: Adjust Highlights

• Move all the highlights at once by moving the cursor over a yellow box until a
four-pointed arrow appears, and then click and drag the grid to line up the
highlights with the fields to index.

• To better match rows and columns, click and drag the red squares on the corners
and sides one at a time to line up the highlights with the rows and columns. You
may need to use the scroll bars to see all the corner squares.

• To move a single yellow box or column of yellow boxes, click and drag the black
square in the center of each yellow box.

3. To return to data entry mode, click the View menu, and then click Adjust
Highlights.

Reset Highlights

You can reset highlights to their default position.

1. Click the View menu, and then click Reset Highlights.
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The highlights will return to their default position.

Change Highlight Color and Transparency

You can change the color and transparency of the highlights and ruler.

1. Click the Tools menu, and then click Options.

2. Click the Display tab.

3. To display a solid highlight, click Solid highlights.

4. To display an outline highlight, click Solid highlights to uncheck the box.

5. Click the Highlight Color drop-down list, and select the color you want.

6. On Highlight Transparency, click and drag the slider.

• To make the highlight less visible, move the slider to the left.
• To make the highlight more visible, move the slider to the right.

7. Click OK.

Use the Ruler

For register-type documents, such as a census, where each line represents one record,
you may want to use the ruler to follow the record across the page.

The biggest difference between using the ruler and the highlights is that the ruler is not
anchored to the image and does not automatically move as you move between data
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entry fields. The ruler stays in one position until you either move the ruler or move the
document under the ruler.

To change the ruler color or transparency, see “Change Highlight Color and Transparen
cy”.

1. Click the View menu, and click Show Ruler.

Note: Selecting the ruler automatically turns off the highlight, if it is available. And
selecting the highlight automatically turns off the ruler. Only one option will display
at a time.

2. To position the ruler on the appropriate line on the image, do one of the following.

• To move the ruler, click the ruler and drag it to the position you want.
• To move the document, click and drag the document to place the image line you

want in the ruler.

3. To turn off the ruler, click the View menu, and click Show Ruler again.

Adjust Ruler Height

You can adjust the height of the ruler.

1. Move your mouse to the top or bottom edge of the ruler.

2. When the mouse cursor turns into a two-pointed arrow, click and drag the edge of
the ruler to make the ruler taller or shorter.
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Chapter 5

Get Help

Help is available on how to use the indexing screens, how to index or arbitrate a project
or a specific field, and other answers to questions. If you cannot find an answer to a question
or problem, you can contact support.

View the Tip of the Day

To help you learn about indexing features, you can view a tip of the day message.

When you sign in to start indexing, a Tip of the Day message appears. There are more
than 60 tips about indexing that you can view. A new tip appears each time you sign
in.

1. Read the tip message. To view the next tip, click Next Tip.

2. To stop the tip from automatically appearing, click Show tips on startup to uncheck
the option.

3. Click Close.

4. To reshow the tips after stopping them, do the following.

a. Click the Tools menu, and click Options.
b. Click the Display tab.
c. Click Show Tip of the Day.
d. Click OK.

The tips will display the next time you sign in to the FamilySearch indexing program.

View Project Instructions

Read the project-specific instructions before indexing or arbitrating a project. These
instructions provide background, guidelines, and examples that need to be followed for
each project.

Click the Project Instructions tab on the right side of the data entry area.

Some projects may have the instructions on the tab. Read the instructions. There
may be links to more information at the bottom.

Note: If you scroll to the end of the instructions, there should be a link to Project
updates. These updates provide answers to questions that occur after a project is
available for indexing. You can recheck these project updates for the latest information
about indexing a project.

You can also find project updates using Ask a Question. When you search for an
answer, type the name of the project, and then type updates, such as Trento Italy
Baptism Records updates.
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View Field Help

Field help provides instructions on how to index a specific field.

Each item of information to be indexed is referred to as a “field.” Where possible, the
fields are labeled to match the labels used on the original document. Help for each field
is located on the right side of the data entry area under the Field Help tab. As you move
from field to field, corresponding instructions explain how to index each field.

1. Click the Field Help tab.

Read the instructions. Some helps have a link to an example you can view. The
example opens in a new window. When you are done viewing the example, click the
X to close the window.

2. To resize the field help area, slowly move your mouse over the dividing bar on the
left side of the Field Help area until you see a small double-headed arrow. Then click
and drag the dividing bar to the size you prefer.

Note: You cannot move the dividing bar all the way to the right.

View System Help

System help provides instructions on how to use the FamilySearch indexing screens.

All of the system help is also available in a printable user guide (see “View Guides”.

1. Press F1.

Note: You can also click the Help menu, and click Help.

2. Click a topic title to view the help.

3. To search for specific help, click the Search button , type what you want to search
for, and press Enter.

View Handwriting Help

You can view an alphabetical list showing how different letters may have been written
to help interpret the handwriting.
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Handwriting styles in earlier time periods may be difficult to interpret. Look on the
image for the same letters in familiar words and compare how they were written. Most
projects have a link to handwriting help within the project instructions.

1. Click the Handwriting Help button.

Note: You can also click the Help menu, and click Handwriting Help.

An alphabetical list appears showing how different letters may have been written.

2. To move the list, click and drag the title bar.

3. To close the list, click the X in the upper right corner.

Other Handwriting Help

You can find additional handwriting help on the FamilySearch indexing
website at: familysearch.org/indexing/help. Select your role, and
then click Handwriting Helps.

View Frequently Asked Questions

You can view answers to frequently asked questions.

1. Click the Help menu, and click Frequently Asked Questions.

You can also access these questions on: familysearch.org/indexing/help. Select
your role, and then click FAQ's.

2. When you are finished, close the frequently asked questions window.

Find Answers to Questions

You can find answers to questions in the FamilySearch Support knowledge base.

1. Click the Help menu, and click Ask a Question.

You can also access these answers on: familysearch.org/indexing/help.

2. At the top, type your question or a few search words, and click Search.

If your question is about a specific project, type the name of the project.

3. In the search results, click a document title to view it.

4. When you are finished, close the Ask a Question window.

View Guides

A user guide and other helpful handouts are available for indexers, arbitrators, and group
administrators or stake indexing directors.

1. Click the Help menu, and click Resource Guide.

You can also access these resources on familysearch.org/indexing/help.

2. Select your role, and then click Training Helps.
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3. On the right, click Indexing User Guide.

4. When you are finished, close the guide window.

View a Quick Start Demonstration

If you are a new indexer, you can view a short demonstration to help you get started
with indexing.

1. Click the Help menu, and click Quick Start.

You can also press Ctrl+Alt+Q.

2. Click the play button to start the video.

3. When you are finished, close the Quick Start window.

View Tutorials

A lesson with a demonstration and practice exercises is available for indexers, arbitrators,
and group administrators or stake indexing directors. These lessons can help you learn
how to index records, arbitrate records, or administer indexing.

1. Click the Help menu, and click Tutorial.
You can also access these tutorials on familysearch.org/indexing/help.

2. Select your role, and then click Tutorial.
3. When you are finished, close the tutorial window.

Viewing News

You can view general news and announcements for FamilySearch indexing on the
website.

News may include indexed records that are now available to search on FamilySearch,
progress on indexing projects, or other general news.

1. On the FamilySearch indexing start page, click the Indexing Links tab.

2. Click FamilySearch Indexing Home Page.

Note: You can also go to the familysearch.org/indexing website.

3. Scroll down to view the list of news articles.

4. Click on an article to view it.

Contact Support

If you cannot find an answer to a question or problem, contact support.

Some groups have a local stake indexing director or group administrator who can provide
training and support. If a local administrator is not available, contact FamilySearch
Support.
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Note: For individuals in an LDS stake group, the group administrator is the stake indexing
director. Community volunteers who are not members of The Church of Jesus Christ of
Latter-day Saints can belong to an LDS stake group. You can join an LDS stake group by
editing your profile information. For those working on partner projects with a society,
a group administrator is selected by the society.

1. Click the Help menu, and click Contact Support.
Contact information for your local administrator and FamilySearch Support is
provided. You can contact your local administrator for questions or extra help with
indexing or arbitrating.

2. To send an e-mail, click an underlined e-mail link, or open your e-mail, and copy
and paste the e-mail address into a new e-mail.

Note: If needed, you can use the batch sharing option to let the support person view
your batch and see a particular problem with an image or record.

3. To call FamilySearch Support, click the underlined phone number link, and locate
the toll-free number for your area.

Finding the Version of the Indexing Program

When you contact support with a problem, they may ask you what version of the
indexing program you have on your computer.

1. Click the Help menu, and click About FamilySearch Indexing.
A window will appear with the version number for the indexing program and Java.

2. After noting the version number, click Close.

Allow Remote Control

When you call FamilySearch Support, the support agent may ask you to allow remote
control so he or she can view your computer and help resolve problems.

Use this option only when requested by FamilySearch Support.

1. Click the Help menu, and click Allow Remote Control.
A window appears about the remote control agent.

Figure 10: Remote Control
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2. On the new window, click Remote Control Agent in red letters.

3. On the security warning message, click Run.

With Firefox, you may need to click Save. If saved, locate the RCAgent.exe file,
and double-click it to run the program.

4. On the second security warning message, click Run.

5. On the Remote Control window, enter your name, and click OK.

Sharing Your Batch View

You can share a view of your batch with another indexer, arbitrator, local leader, or
support agent.

There are two situations where you may find batch sharing helpful:

• If you are having a problem with a batch, you can share your batch view with your
local leader or FamilySearch Support so they can better understand the problem and
help resolve it.

• If you are teaching a class where all the students have their own computer, you can
share your batch view with students. There is no limit on how many people can view
the batch at the same time.

Note:  In order to share batches, the sharer and the viewer must have rights to view the
batches. For example, if an indexer is working on a partner project, the viewer must also
have rights to download a batch from that project.

1. Click the File menu, and click Share Batch.
A message appears with a number.

2. Write down the number, and click Copy.

Note: This number is not related to the microfilm number or batch number of the
document image.
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3. Give this number to the person with whom you want to share your batch. This person
will need to do the following.

a. From the indexing start page, click the File menu, and click View Shared Batch.

b. Enter the number, and click OK.
The batch is downloaded, and the person can view it. More than one person may
retrieve the batch and display it on his or her screen.

• Viewers are able to type information into a field, but they cannot save, submit,
or do anything with the batch. The batch is downloaded for viewing only. Only
the indexer can save information in the batch and submit it.

• The viewer can go to the indexing start page and back to the batch image, but
when the viewer logs out of FamilySearch indexing, the batch is no longer
available for them to view.

• The viewer can still see the batch if he or she goes to work offline, but when
he or she returns to work online, the batch will be cleared from his or her My
Work list.

4. To share additional data that you have typed for a batch, click the Save  button.

a. To view the data you have typed for a batch, the viewer must click the File menu,
and click Retrieve from Server.
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Chapter 6

Get Training

There are various resources available to help with training indexers, arbitrators, and group
administrators.

Training for Indexers and Arbitrators

Various training resources are available.

• Attend any training sessions conducted by your local leader.
• Indexers and arbitrators should complete the tutorials available on

familysearch.org/indexing/help. Select your role, and then click Tutorial.
• Before indexing or arbitrating a project, read the project-specific instructions available

for that project on the Project Instructions tab on the right side of the data entry area
of the indexing screen.

• View the Field Help tab on the right side of the data entry area of the indexing screen.
• Watch for training tips posted in the My Messages section of the FamilySearch indexing

start page.
• View other help resources available on the website.

Training for Group Administrators

Various training resources are available.

• Complete the training tutorial available on familysearch.org/indexing/help.
Select your role, and then click Tutorial.

• Watch for training tips posted in the My Messages section of the FamilySearch indexing
start page.

• View other help resources on the website.

Training for Stake Indexing Directors

Various training resources are available.

The high councilor over family history instructs the stake indexing director regarding
the organization and objectives of indexing within the stake. Use the following resources
to learn the details of the indexing process.

• See the resources on lds.org for stake indexing directors.

1. Go to www.lds.org, click Resources, and select All Callings.
2. Click Family History.
3. Under Training for My Calling, click Stake Indexing Director.
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4. Click an item to view it.

• See the resources on familysearch.org/indexing/help. Select your role, and then
click a help resource.

• Watch for tips posted in the My Messages section of the FamilySearch indexing start
page.
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Chapter 7

Arbitration

To ensure the best quality, each record is indexed by two people: an A indexer and a B
indexer. When both the A and B indexing have been submitted, the system compares the
two versions. If there are any differences, the batch is sent for arbitration.

An arbitrator compares the differences with the document image and either selects the
most correct version or types in a new value that more accurately reflects what is on the
image.

Who Can Arbitrate?

Arbitrators are assigned by the local group administrator or stake indexing director.

The local leader typically looks for:

• An experienced indexer who pays attention to details.
• An indexer who is willing to follow project instructions, even if he or she has a

different opinion on how a record should be indexed.

An indexer must be assigned the arbitrator role by his or her local leader before he or
she can download arbitration batches.

Arbitration Steps

Arbitration consists of a few simple steps.

In arbitration batches, the system has found differences between the values from the A
indexer and B indexer.
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Figure 11: Download a Batch

1. To download an arbitration batch, click the drop-down list, and select Arbitrator.

2. Click Download Batch.

A list of projects will appear.

• The highest priority project is highlighted in red.
• Projects are listed alphabetically by project name. To sort the list by language,

difficulty level, or points, click the column heading Description, Level, or
Points.

• To see all projects, at the top, click Show all projects.
• To see only the projects that match your preference settings, at the top, click Show

preferred projects.

Note: If no projects match your preference settings, the list will be blank.

• To change your preference settings, click Edit My Preferences. Sign in to the
FamilySearch indexing website, and edit your preferences.

Note: If you edit your preferences, the list will close, and you will need to click
Download Batch again to see the updated list.

• To see what the images in a project look like, click a project, and then click View
Sample.

3. Click the name of the project you want to work on.

4. Select the number of batches you want to work on. You can have up to 10 batches
downloaded at one time.

5. Click OK.

Note: You can also double-click the name of a project to download a batch from that
project.

6. If someone else has worked on the batch you downloaded, but it was returned before
he or she could finish, you will see a message that this batch has been previously
arbitrated. Click OK.

Note: Be sure to check what the previous arbitrator has done.

7. Read the message stating that this batch has been indexed, and then click Next.
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8. Read the message about project instructions, and then click Close.

The document image or images are temporarily copied onto your computer.

Check the record matching before you start arbitration. If the batch is a register-type
document, with multiple records on one image, you need to first check that the records
from the A indexer and B indexer line up or match. Either one or the other of the indexers
may have accidentally skipped a row or duplicated a row so that the names do not match.
If you start arbitration and then decide you need to re-align some rows, the work you
have done in arbitration will be lost.

Note: You cannot change or enter any values while on the Record Matching tab.

1. Click the Record Matching tab.

Figure 12: Record Matching

All the records for the first image from both the A and B indexer are displayed in the
order in which the indexers typed them. They are identified as “Key A Records” and
“Key B Records.”

2. Compare the names between the two columns.

• Sometimes the data you can see is just a series of commas. If needed, you can
adjust which fields show and the order in which they appear. You can change the
order to display names first to help you compare the records.

• To adjust the fields, right-click in the column heading for “Key A Records” or
“Key B Records,” and select Record Matching Fields.
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• To move a field, in the Selected Fields list, click a field name, and click the up
or down arrow to move the field in the list.

• To hide a field, in the Selected Fields list, click a field name, and click the right
arrow to move the field to the Hidden fields list.

• Click OK.

Note: Any adjustments you make to fields, including hiding fields, only applies
to the Record Matching tab. It does not affect how fields appear on the Arbitration
tab.

• You can also adjust the size of the Record Matching tab to view more of the data.
Slowly move your mouse over the dividing bar on the right side of the Record
Matching area until you see a small double-headed arrow. Then click and drag the
dividing bar to the size you prefer.

Note: You cannot move the dividing bar all the way to the right.

Tip: All nonmatching letters are displayed in red. Some red is expected since the
values between the indexers may have some differences. When it appears that most
of the values between the two are different, it may indicate that the rows do not
match.

3. If you need to add, remove, or change the order of the rows to get them to match
up, do one of the following.
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DescriptionOption

If one of the columns shows a name that does not appear in the
other column, click the name, and then click No Matching

Add a Row

Record(s). A row will be added in the opposite column marked
<Empty>, and the remaining records will be moved down.

If one of the columns has the same name twice, click the duplicate
name, and then click Remove Record(s). That row will be removed,
and the remaining records will be moved up.

Remove a Row

If one column has correct names but in a different order than the
other column, click the name to highlight it, and then click the Up

Change the
Order

 or Down arrow at the top to move that record up or down
to match the correct column.

Note: To move multiple rows at once, click the first record, press
the Shift key, and click the last record. The rows will be highlighted.

To insert a row in both columns to type a name that was missed by
both the A and B indexer, click the row just below where you need

Insert a Line

to insert a line, and then click the Insert new line above selected

record  button.

To remove a blank row in both columns, click the row to highlight
it, and then click the Delete selected lines from both columns

 button.

Delete a Line

4. If you make a mistake and need to undo the changes, click Reset.
The system will return both columns to the way they were when you started.

5. To save your changes, click Finished.

Reindexing a Batch

If either the A or B index is incomplete or has significant quality problems, the batch
needs to be reindexed.

There is no set of rules for when you should fix problems or send a batch back to be
reindexed. However, you are an arbitrator, not a third indexer. If you are fixing a lot of
problems, you may want to return the batch to be reindexed.

Send the batch back for reindexing if you see these problems.

• An indexer has indexed the wrong page of records and none of the names match.
• An indexer has skipped a significant number of records.

Do not send the batch back if you see these problems.

• The records are in the wrong order. You can fix this on the Record Matching tab.
• A year designation is missing (y) or the wrong letter was used. This is a simple fix.
• An indexer skipped only a few records.
• An indexer used all capital letters for the data. Although mixed case is preferred, the

system does not differentiate between mixed case and all capitals. You may select
data in all capitals as being the correct information, or you can change it to mixed
case if you want.

1. Click the Redo: have this batch indexed again  button.
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2. Click the batch to be reindexed, either Reindex A Key or Reindex B Key.

3. Click the reason for sending the batch to be reindexed, Incorrect information or
Batch is incomplete.

4. Click OK.

When a batch is sent back for reindexing, the following occurs.

• For “incorrect information,” all the values are erased, and the batch is sent to the
next available indexer as a new batch.

• For “batch is incomplete,” the data is kept, and the batch is sent to the next available
indexer as a partially completed batch. The original indexer is no longer attached to
this batch, and so he or she cannot review it later.

The Arbitration Tab displays the values entered by both the A indexer and the B indexer.
Review each field that has been flagged with a discrepancy, compare it with the
information on the document, and either select the A value, the B value, or enter a new
value for the field.

The arbitration screen looks very similar to the indexing screen. The data entered by the
A and B indexers is shown side-by-side for easy comparison. If both the A and B values
agree, the information is grayed out, and the value appears in the Arbitrator column.

The system displays the arbitration symbol  in the Records column for each record
that has discrepancies. Field values that do not match are marked with the same symbol
in the Arbitrator column. The system automatically displays the first field where the
values do not agree. Information that does not match is shown in red.
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Figure 13: Arbitration

1. When you are finished with record matching, the system automatically displays the
Arbitration tab. If a message appears asking if you want to save the changes you made
in Record Matching, click Yes.

2. Although arbitration checks all the fields, click the Header Data tab, and check for
any differences between Key A and Key B in the header data. If the batch has more
than one image, click the image numbers at the left to check the header data for each
image. Then click the Arbitration tab to continue arbitration.

Arbitrate Using the Columns

You can arbitrate a record using the columns on the Arbitration tab.

1. Compare the values with the document image, and indicate the correct value.

• If the A value is correct, click the field in the Key A column.
• If the B value is correct, click the field in the Key B column.
• If neither value is correct, enter a new value in the Arbitrator column.

2. Press Tab or Enter to move to the next value that needs arbitration.

If you make a mistake and need to correct it, click the Undo button.
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The A and B values are grayed out, and a value appears in the Arbitrator column. The
system displays the next value that needs arbitration.

Arbitrate Using the Panel

You can arbitrate using the Arbitration tab on the right side.

1. Compare the values with the document image, and indicate the correct value.

• If the A value is correct, click Accept Key A.
• If the B value is correct, click Accept Key B.
• If neither value is correct, enter a new value in the Arbitrator column. Then

click Accept Arbitration.

2. The system automatically moves to the next field that needs arbitration.

Note: You can also press Tab or Enter, or click Next to see the next field to be
arbitrated.

If you make a mistake and need to correct it, click the Undo button.

3. If you want to return to a previous arbitration, click Back.

When all the discrepant fields have been arbitrated, the quality check will review only
the new values you entered.

Before you submit a batch, you must do a quality check on the information you entered.

As you enter data, any information that does not match the lookup list appears with a
red wavy line or colored background. This is not an indication that you made a mistake.
The lookup lists are limited and may not include every variation in spelling, particularly
for names. The lists are intended as a guide to help you decipher information that is
difficult to read. During the quality check, you recheck any data marked with a red wavy
line or colored background. You may change the data or indicate that what you entered
is correct.

When you are finished arbitrating, a message asks if you would like to check the quality.
If you indicate yes, the Quality Checker window replaces the Field Help window on the
right side of the data entry area. The first marked field appears along with an explanation
of why the data needs to be rechecked. If the Quality Checker does not appear, click the
Quality Checker tab. The quality check looks at any fields marked with a red wavy
line or colored background and at any required fields that are left blank or need to be
reconciled.

Note: You can click the Quality Checker tab at any time to check marked names. You
do not have to wait until you are finished.
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Figure 14: Quality Check

1. Recheck the information you typed with what you see on the image.

• To keep what you entered, click Accept.
• To keep what you entered for the same field in all records, click Accept All.
• To change what you entered, type the new data in the field.

Note: If the value you enter is not in the Lookup list, the quality checker may
present this field again. You can then click Accept to keep what you entered.

• To change what you entered for the same field in all records, type the new data
in the field, and click Change all to new value. On the confirmation message,
click Yes.

2. When you click an Accept or the Change all to new value button, the quality
checker automatically moves to display the next field with a red wavy line or colored
background.

Note: You may also click Next to go to the next marked field.

3. To return to a previous decision, click Back.

4. When the quality check is finished, on the message to submit the batch, click Yes.

When you have finished indexing a batch, you need to submit it. When you submit a
batch, the information is saved on the server, and the system removes the images and
information from your computer.

1. After the quality check is complete, a message appears asking if you want to submit
the batch. Click Yes.

If you did not do the quality check, the system will automatically start the quality
check process before submitting the information. If there are no fields to check, the
batch will be submitted.
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Note: You can also click the Submit  button, or click the File menu, and click
Submit. On the FamilySearch indexing start page in the My Batches section, you
can also click the batch, and then click the Submit Batch button.

2. On the Batch successfully submitted message, click OK.

Once you submit a batch, it is considered finished. You cannot retrieve it to fix a mistake.
However, each batch is indexed twice, by an A indexer and a B indexer, and if there are
differences, the batch is viewed by an arbitrator, who will fix errors. Once an arbitrator
has submitted a batch, it is considered finished.

Opening a Previously Downloaded Arbitration Batch

If you saved your work, you can return at a later time to finish a batch.

You have seven days in which to finish a batch. The due date is listed in the My Batches
section. The system will warn you when a batch is about to expire. If you cannot finish
the batch, after seven days it will automatically be retrieved by the system and assigned
to the next arbitrator who requests a batch for that project.

Note: Arbitration batches are marked by the arbitration symbol  in the Type column
of the My Batches section.

Figure 15: My Batches section

1. In the My Batches section of the FamilySearch indexing start page, double-click the
batch you want to work on.

Note: You can also click on the batch, and then click the Work on Batch button.

2. If you are working from a different computer and do not see the previous information
you entered, click the File menu, and click Retrieve from Server.
Information that you typed on another computer and saved to the server may not
be visible until you retrieve it from the server. Information that you typed on the
same computer will display.
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